Note the following details of the code protection feature on Microchip devices:

- Microchip products meet the specification contained in their particular Microchip Data Sheet.
- Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the intended manner and under normal conditions.
- There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip’s Data Sheets. Most likely, the person doing so is engaged in theft of intellectual property.
- Microchip is willing to work with the customer who is concerned about the integrity of their code.
- Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.

Information contained in this publication regarding device applications and the like is provided only for your convenience and may be superseded by updates. It is your responsibility to ensure that your application meets with your specifications. MICROCHIP MAKES NO REPRESENTATIONS OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY OR OTHERWISE, RELATED TO THE INFORMATION, INCLUDING BUT NOT LIMITED TO ITS CONDITION, QUALITY, PERFORMANCE, MERCHANTABILITY OR FITNESS FOR PURPOSE. Microchip disclaims all liability arising from this information and its use. Use of Microchip devices in life support and/or safety applications is entirely at the buyer’s risk, and the buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual property rights unless otherwise stated.

Trademarks
The Microchip name and logo, the Microchip logo, AnyRate, AVR, AVR logo, AVR FREAKS, BeaconThings, BitCloud, CryptoMemory, CryptoRF, dsPIC, FlashFlex, flexPWR, Helda, JukeBlox, KEELOQ, KEELOQ logo, Kleer, LANCHECK, LINK MD, maXYtus, maXTouch, MediaLB, megaAVR, MOST, MOST logo, MPLAB, OptoLyzer, PIC, picoPower, PICSTART, PIC32 logo, Prochip Designer, QTouch, RightTouch, SAM-BA, SpyNIC, SST, SST Logo, SuperFlash, tinyAVR, UNI/O, and XMEGA are registered trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

ClockWorks, The Embedded Control Solutions Company, EtherSynch, Hyper Speed Control, HyperLight Load, IntellIMOS, mTouch, Precision Edge, and Quiet-Wire are registered trademarks of Microchip Technology Incorporated in the U.S.A.


SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

Silicon Storage Technology is a registered trademark of Microchip Technology Inc. in other countries.

GestIC is a registered trademark of Microchip Technology Germany II GmbH & Co. KG, a subsidiary of Microchip Technology Inc., in other countries.

ARM
ARM and Cortex are registered trademarks of ARM Limited in the EU and other countries.

All other trademarks mentioned herein are property of their respective companies.

© 2018, Microchip Technology Incorporated, All Rights Reserved.
ISBN: 978-1-5224-3376-7
Object of Declaration: MPLAB® PICkit™ 4 In-Circuit Debugger

EU Declaration of Conformity

This declaration of conformity is issued by the manufacturer. The development/evaluation tool is designed to be used for research and development in a laboratory environment. This development/evaluation tool is not intended to be a finished appliance, nor is it intended for incorporation into finished appliances that are made commercially available as single functional units to end users. This development/evaluation tool complies with EU EMC Directive 2004/108/EC and as supported by the European Commission's Guide for the EMC Directive 2004/108/EC (8th February 2010). This development/evaluation tool complies with EU RoHS2 Directive 2011/65/EU. This development/evaluation tool, when incorporating wireless and radio-telecom functionality, is in compliance with the essential requirement and other relevant provisions of the R&TTE Directive 1999/5/EC and the FCC rules as stated in the declaration of conformity provided in the module datasheet and the module product page available at www.microchip.com.

For information regarding the exclusive, limited warranties applicable to Microchip products, please see Microchip’s standard terms and conditions of sale, which are printed on our sales documentation and available at www.microchip.com.

Signed for and on behalf of Microchip Technology Inc. at Chandler, Arizona, USA.

Rodger Richey
Director of Development Tools

Date: 4/4/17
# Table of Contents

**Preface** .......................................................................................................................... 7

**Chapter 1. About the In-Circuit Debugger**

1.1 Introduction .................................................................................................................. 13
1.2 MPLAB PICkit 4 In-Circuit Debugger Description .................................................. 13
1.3 MPLAB PICkit 4 In-Circuit Debugger Advantages .................................................. 14
1.4 MPLAB PICkit 4 In-Circuit Debugger Components .................................................. 15
1.5 MPLAB PICkit 4 Block Diagram ............................................................................... 16

**Chapter 2. Operation**

2.1 Introduction ................................................................................................................. 17
2.2 Debugger to Target Communication ........................................................................ 17
2.3 Target Communication Connections ....................................................................... 19
2.4 Debugging ................................................................................................................... 21
2.5 Requirements for Debugging .................................................................................... 22
2.6 Programming ............................................................................................................... 24
2.7 Resources Used by the Debugger ............................................................................. 25

**Chapter 3. Debugger Usage**

3.1 Introduction ................................................................................................................. 27
3.2 Installation and Setup ............................................................................................... 27
3.3 Debug Tutorial ........................................................................................................... 28
3.4 Quick Debug/Program Reference ............................................................................ 28
3.5 Debugger Limitations ............................................................................................... 29
3.6 Common Debug Features ......................................................................................... 29
3.7 Connecting the Target Board .................................................................................... 29
3.8 Setting Up the Target Board .................................................................................... 29
3.9 Setting Up MPLAB X IDE ......................................................................................... 30
3.10 Starting and Stopping Debugging ........................................................................... 31
3.11 Viewing Processor Memory and Files ..................................................................... 31
3.12 Breakpoints and Stopwatch .................................................................................... 31

**Chapter 4. Troubleshooting First Steps**

4.1 Introduction ................................................................................................................. 35
4.2 Some Questions to Answer First .............................................................................. 35
4.3 Top Reasons Why You Can’t Debug ......................................................................... 35
4.4 Other Things to Consider ......................................................................................... 36

**Chapter 5. Frequently Asked Questions (FAQs)**

5.1 Introduction ................................................................................................................. 39
5.2 How Does It Work .................................................................................................... 39
5.3 What’s Wrong ............................................................................................................ 39
INTRODUCTION

These topics contain general information that will be useful to know before using the MPLAB® PICkit™ 4 In-Circuit Debugger. Items discussed in this chapter include:

- Document Layout
- Conventions Used in this Guide
- Recommended Supplemental Reference

DOCUMENT LAYOUT

This document describes how to use the MPLAB® PICkit™ 4 In-Circuit Debugger as a development tool to emulate and debug firmware on a target board, as well as how to program devices. The document is organized as follows:

Part 1 – Getting Started

- **Chapter 1. About the In-Circuit Debugger** – What the MPLAB® PICkit™ 4 In-Circuit Debugger is and how it can help you develop your application.
- **Chapter 2. Operation** – Provides a theory of operation for the MPLAB® PICkit™ 4 In-Circuit Debugger. Explains some configuration options.
- **Chapter 3. Debugger Usage** – Discusses general uses of the in-circuit debugger.

Part 2 – Troubleshooting

- **Chapter 4. Troubleshooting First Steps** – The first things you should try if you are having issues with debugger operation.
- **Chapter 5. Frequently Asked Questions (FAQs)** – A list of frequently asked questions, useful for troubleshooting.
- **Chapter 6. Error Messages** – A list of error messages and suggested resolutions.
Part 3 – Reference

- **Appendix A. Debugger Function Summary** – A summary of debugger functions available in MPLAB® X IDE when the MPLAB® ICD 4 debugger is chosen as the debug or program tool.
- **Appendix B. Hardware Specification** – The hardware and electrical specifications of the debugger system.
- **Appendix C. Revision History**

**CONVENTIONS USED IN THIS GUIDE**

This manual uses the following documentation conventions:

**DOCUMENTATION CONVENTIONS**

<table>
<thead>
<tr>
<th>Description</th>
<th>Represents</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arial font:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Italic characters</td>
<td>Referenced books</td>
<td><em>MPLAB® IDE User’s Guide</em></td>
</tr>
<tr>
<td></td>
<td>Emphasized text</td>
<td><em>...is the only compiler...</em></td>
</tr>
<tr>
<td>Initial caps</td>
<td>A window</td>
<td>the Output window</td>
</tr>
<tr>
<td></td>
<td>A dialog</td>
<td>the Settings dialog</td>
</tr>
<tr>
<td></td>
<td>A menu selection</td>
<td>select Enable Programmer</td>
</tr>
<tr>
<td>Quotes</td>
<td>A field name in a window or dialog</td>
<td>“Save project before build”</td>
</tr>
<tr>
<td>Underlined, italic text with right angle bracket</td>
<td>A menu path</td>
<td>File&gt;Save</td>
</tr>
<tr>
<td>Bold characters</td>
<td>A dialog button</td>
<td>Click OK</td>
</tr>
<tr>
<td></td>
<td>A tab</td>
<td>Click the Power tab</td>
</tr>
<tr>
<td>N’Rnnnn</td>
<td>A number in verilog format, where N is the total number of digits, R is the radix and n is a digit.</td>
<td>4'b0010, 2'hF1</td>
</tr>
<tr>
<td>Text in angle brackets &lt; &gt;</td>
<td>A key on the keyboard</td>
<td>Press &lt;Enter&gt;, &lt;F1&gt;</td>
</tr>
</tbody>
</table>

**Courier New font:**

<table>
<thead>
<tr>
<th>Description</th>
<th>Represents</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain Courier New</td>
<td>Sample source code</td>
<td>#define START</td>
</tr>
<tr>
<td></td>
<td>Filenames</td>
<td>autoexec.bat</td>
</tr>
<tr>
<td></td>
<td>File paths</td>
<td>c:\mcc18\h</td>
</tr>
<tr>
<td></td>
<td>Keywords</td>
<td>_asm, _endasm, static</td>
</tr>
<tr>
<td></td>
<td>Command-line options</td>
<td>-Opa+, -Opa-</td>
</tr>
<tr>
<td></td>
<td>Bit values</td>
<td>0, 1</td>
</tr>
<tr>
<td></td>
<td>Constants</td>
<td>0xFF, ‘A’</td>
</tr>
<tr>
<td>Italic Courier New</td>
<td>A variable argument</td>
<td>file.o, where file can be any valid filename</td>
</tr>
<tr>
<td>Square brackets [ ]</td>
<td>Optional arguments</td>
<td>mcc18 [options] file [options]</td>
</tr>
<tr>
<td>Curly brackets and pipe character: {</td>
<td>Choice of mutually exclusive arguments; an OR selection</td>
<td>errorlevel {0</td>
</tr>
<tr>
<td>Ellipses...</td>
<td>Replaces repeated text</td>
<td>var_name [, var_name...]</td>
</tr>
<tr>
<td>Represente code supplied by user</td>
<td>void main (void) { ... }</td>
<td></td>
</tr>
</tbody>
</table>
RECOMMENDED SUPPLEMENTAL REFERENCE

This user’s guide describes how to use MPLAB® PICkit™ 4 In-Circuit Debugger. Other useful documents are listed below. The following Microchip documents are available and recommended as supplemental reference resources.

Multi-Tool Design Advisory (DS51764)

Please read this first! This document contains important information about operational issues that should be considered when using the MPLAB PICkit 4 with your target design.

MPLAB X IDE Online Help

This is an essential document to be used with any Microchip hardware tool. This is an extensive help file for the MPLAB X IDE. It includes an overview of embedded systems, installation requirements, tutorials, details on creating new projects, setting build properties, debugging code, setting configuration bits, setting breakpoints, programming a device, etc. This help file is generally more up-to-date than the printable PDF of the user’s guide (DS50002027) available as a free download at http://www.microchip.com/mplabx/.

Release Notes for MPLAB PICkit 4 In-Circuit Debugger

For the latest information on using MPLAB® PICkit™ 4 In-Circuit Debugger, read the notes under “Release Notes and Support Documentation” on the MPLAB X IDE Start Page. The release notes contain updated information and known issues that may not be included in this user’s guide.

MPLAB PICkit 4 Quick Start Guide (DS50002721)

This poster provides basic information on how to install the software and connect the hardware for the MPLAB PICkit 4 In-Circuit Debugger using standard communications and a target board.

Getting Started with MPLAB PICkit 4 In-Circuit Debugger Webinar

An informative video on how to set up the MPLAB PICkit 4 debugger.

MPLAB PICkit 4 In-Circuit Debugger Online Help File

A comprehensive help file for the debugger is included with MPLAB X IDE. Usage, troubleshooting and hardware specifications are covered. This help file may be more up-to-date than the printed documentation.

Processor Extension Pak and Header Specification (DS50001292)

This booklet describes how to install and use headers. Headers are used to better debug selected devices, without the loss of pins or resources. See also the PEP and Header online Help file.

Transition Socket Specification (DS51194)

Consult this document for information on transition sockets available for use with headers.
Chapter 1. About the In-Circuit Debugger

1.1 INTRODUCTION

An overview of the MPLAB® PICkit™ 4 In-Circuit Debugger system is provided here.

- MPLAB PICkit 4 In-Circuit Debugger Description
- MPLAB PICkit 4 In-Circuit Debugger Advantages
- MPLAB PICkit 4 In-Circuit Debugger Components
- MPLAB PICkit 4 Block Diagram

1.2 MPLAB PICKIT 4 IN-CIRCUIT DEBUGGER DESCRIPTION

The MPLAB PICkit 4 In-Circuit Debugger (PG164140) allows fast and easy debugging and programming of Microchip PIC®, dsPIC® flash and the CEC (ARM® Cortex®-M7-based) microcontrollers, using the powerful graphical user interface of MPLAB X Integrated Development Environment (IDE). The MPLAB PICkit 4 is connected to the design engineer's computer using a high-speed 2.0 USB interface and can be connected to the target via a Microchip debug 8-pin Single In-Line (SIL) connector. The connector uses two device I/O pins and the reset line to implement in-circuit debugging and In-Circuit Serial Programming™ (ICSP™). An additional micro SD card slot and the ability to be self-powered from the target means you can take your code with you and program on the go.

The MPLAB PICkit 4 programs faster than its predecessor and comes ready to support PIC, dsPIC and CEC MCU devices. Along with a wider target voltage, the MPLAB PICkit 4 supports advanced interfaces such as 4-wire JTAG and Serial Wire Debug with streaming Data Gateway, while being backward compatible for demo boards, headers and target systems using 2-wire JTAG and ICSP. The MPLAB PICkit 4 also has a unique programmer-to-go function with the addition of a micro SD card slot to hold project code and the ability to be powered by the target board.

The debugger system executes code like an actual device because it uses a device with built-in emulation circuitry, instead of a special debugger chip. All available features of a given device are accessible interactively, and can be set and modified by the MPLAB X IDE interface.

The MPLAB PICkit 4 In-Circuit Debugger is compatible with any of these platforms:

- Microsoft Windows® 7 or later
- Linux®
- macOS™

1. This functionality is coming soon with a firmware update of the product through MPLAB X IDE.
The MPLAB PICkit 4 debugger was developed for debugging embedded processors with rich debug facilities which differ from conventional system processors in the following aspects:

• Processors run at maximum speeds
• Capability to incorporate I/O port data input
• Advanced host communication interfaces (Windows, macOS and Linux)
• Advanced communication mediums and protocols
• Faster programming times
• Capability to be used as a device production programmer

1.3 MPLAB PICKIT 4 IN-CIRCUIT DEBUGGER ADVANTAGES

The MPLAB PICkit 4 In-Circuit Debugger system provides the following advantages:

Features/Capabilities:

• Connects to computer via high-speed USB 2.0 (480 Mbits/s) cable
• An 8-pin SIL programming connector and the option to use various interfaces
• Programs devices using MPLAB X IDE or MPLAB IPE
• Supports multiple hardware and software breakpoints, stopwatch, and source code file debugging
• Debugs your application on your own hardware in real time
• Sets breakpoints based on internal events
• Monitors internal file registers
• Debugs at full speed
• Configures pin drivers
• Field-upgradeable through an MPLAB X IDE firmware download
• Adds new device support and features by installing the latest version of MPLAB X IDE (available as a free download at http://www.microchip.com/mplabx/)
• Indicates debugger status via the indicator light strip

Performance/Speed:

• More and faster memory
• A Real-Time Operating System (RTOS)
• No firmware download delays incurred when switching devices
• A 32-bit MCU running at 300 MHz

Safety:

• Receive feedback from debugger when external power supply is needed for target
• Supports target supply voltages from 1.2V to 5.5V
• Protection circuitries are added to the probe drivers to guard from power surges from the target
• VDD and VPP voltage monitors protect against overvoltage conditions/all lines have over-current protection
• Programming/debugging pins are physically isolated until voltage is determined to be safe for connection, programmable resistor value, and direction (pull-up, pull-down, or nonexistent).
• Controlled programming speed provides flexibility to overcome target board design issues
• CE and RoHS compliant – conforms to industry standards
1.4  MPLAB PICKIT 4 IN-CIRCUIT DEBUGGER COMPONENTS

The components of the MPLAB PICkit 4 In-Circuit Debugger system are:

- A rectangular-shaped MPLAB PICkit 4 unit housed in a durable, black plastic case with a brushed metal top which is accented with an indicator light strip, button area.
- A Micro-B USB connector.
- Micro SD card slot.
- Emergency recovery button.
- Lanyard connector.
- A Micro-B USB cable to provide communications between the debugger and a computer, as well as providing power to the debugger.

FIGURE 1-1:  BASIC DEBUGGER SYSTEM

Additional hardware and accessories may be ordered separately from Microchip Direct (http://www.microchipdirect.com/).

- Debugger Adapter Board (Part No. AC102015) - a connectivity board that supports JTAG, SWD and ICSP protocols, useful for debugging legacy AVR with MPLAB PICkit 4
- Transition sockets
- ICD headers
- MPLAB processor extension kits
1.5 MPLAB PICKIT 4 BLOCK DIAGRAM
Chapter 2. Operation

2.1 INTRODUCTION

A simplified theory of operation of the MPLAB® PICkit™ 4 In-Circuit Debugger system works is provided here. It is intended to provide enough information so a target board can be designed that is compatible with the debugger for both debugging and programming operations. The basic theory of in-circuit debugging and programming is described so that problems, if encountered, are quickly resolved.

- Debugger to Target Communication
- Target Communication Connections
- Debugging
- Requirements for Debugging
- Programming
- Resources Used by the Debugger

2.2 DEBUGGER TO TARGET COMMUNICATION

The debugger is connected to the computer via a USB cable for communication and debugger power.

The debugger is connected to the target application for communication and data collection and optional debugger power.

The debugger system configurations are discussed in the following sections.

*Note:* The MPLAB X IDE software must be installed prior to connecting the MPLAB PICkit 4 In-Circuit Debugger.

**CAUTION**

Communication Failure.
Do not connect the hardware before installing the software and USB drivers.

**CAUTION**

Debugger or Target Damage.
Do not change hardware connections while the debugger or target is powered.

*Note:* The MPLAB PICkit 4 in-circuit debugger is warranted for operation using the provided cable. Cables from other vendors may result in communication errors.
2.2.1 Standard ICSP™ Device Communication

The debugger system can be configured to use standard ICSP communication for both programming and debugging functions.

Make sure to align the Pin 1 on the debugger to Pin 1 on the target. The programming connector can be inserted into either:

- A matching connector at the target, where the target device is on the target board (Figure 2-1).
- A standard adapter/header board combo (available as a Processor Pak), which is then plugged into the target board (Figure 2-2).

For more on standard communication, see Section B.4.1 “Standard Communication”.

FIGURE 2-1: STANDARD DEBUGGER SYSTEM – DEVICE WITH ON-BOARD ICE CIRCUITRY

FIGURE 2-2: STANDARD DEBUGGER SYSTEM – ICE DEVICE
2.3 TARGET COMMUNICATION CONNECTIONS

### 2.3.1 Standard Communication Target Connections

#### 2.3.1.1 USING SINGLE IN-LINE CONNECTOR

Use the single in-line connector between the MPLAB PICkit 4 In-Circuit Debugger and the target board connector (see Figure 2-1 and Section B.4 “Standard Communication Hardware”).

#### 2.3.1.2 USING AN ADAPTER

Use the AC164110 adapter between the MPLAB PICkit 4 In-Circuit Debugger and the target device with the modular interface (six conductor) cable. The pin numbering for the connector is shown from the bottom of the target PCB in Figure 2-3.

**FIGURE 2-3: STANDARD RJ-11 CONNECTION AT TARGET**

#### 2.3.2 Target Connection Circuitry

Figure 2-4 shows the interconnections of the MPLAB PICkit 4 In-Circuit Debugger to the connector on the target board. The diagram also shows the wiring from the connector to a device on the target PCB. A pull-up resistor (usually around 10-50 kΩ) is recommended to be connected from the VPP/MCLR line to VDD so that the line may be strobed low to reset the device.

**FIGURE 2-4: STANDARD CONNECTION TO TARGET CIRCUITRY**

---

**Note:** Refer to the data sheet for the device you are using as well as the application notes for the specific interface for additional information and diagrams.
### 2.3.3 Target Powered

In the following descriptions, only three lines are active to core debugger operation: pins 1 (VPP/MCLR), 5 (PGC) and 4 (PGD). Pins 2 (VDD) and 3 (VSS) are shown on Figure 2-4 for completeness. MPLAB PICkit 4 has two configurations for powering the target device: internal debugger and external target power.

The recommended source of power is external and derived from the target application (see Figure 2-5). In this configuration, target VDD is sensed by the debugger to allow level translation for the target low voltage operation. If the debugger does not sense voltage on its VDD line (pin 2 of the interface connector), it will not operate.

**FIGURE 2-5: TARGET POWERED FROM EXTERNAL SOURCE**

![External Power Supplied to Target Diagram](image)

### 2.3.4 Debugger Powered

If the target is powered through the debugger with an externally powered hub as shown below, the power available to the target is limited to 50 mA.

**FIGURE 2-6: TARGET POWERED THROUGH SELF-POWERED HUB**

![Target Powered Through Self-Powered Hub Diagram](image)

Not all devices have the AVDD and AVss lines, but if they are present on the target device, all must be connected to the appropriate levels in order for the debugger to operate. They cannot be left floating.

Also, devices with a VCAP line (PIC18FXXJ for example) should be connected to the appropriate capacitor or level.

**Note:** The interconnection is very simple. Any problems experienced are often caused by other connections or components on these critical lines that interfere with the operation of the MPLAB PICkit 4 In-Circuit Debugger, as discussed in the following section.
2.3.5 Circuits That Will Prevent the Debugger From Functioning

Figure 2-7 shows the active debugger lines with some components that will prevent the MPLAB PICkit 4 debugger system from functioning.

Specifically, these guidelines must be followed:

- Do not use pull-ups on PGC/PGD – they will disrupt the voltage levels, since these lines have programmable pull-down resistors in the debugger.
- Do not use capacitors on PGC/PGD – they will prevent fast transitions on data and clock lines during programming and debug communications.
- Do not use capacitors on MCLR – they will prevent fast transitions of VPP. A simple pull-up resistor is generally sufficient.
- Do not use diodes on PGC/PGD – they will prevent bidirectional communication between the debugger and the target device.

2.4 DEBUGGING

There are two steps to using the MPLAB PICkit 4 In-Circuit Debugger system as a debugger. The first requires that an application be programmed into the target device (usually with the MPLAB PICkit 4 itself). The second uses the internal in-circuit debug hardware of the target Flash device to run and test the application program. These two steps are directly related to the MPLAB X IDE operations:

1. Programming the code into the target and activating special debug functions.
2. Debugging the code using features such as breakpoints.

**Note:** For information on debugging, refer to the MPLAB X IDE online Help.

If the target device cannot be programmed correctly, the MPLAB PICkit 4 In-Circuit Debugger will not be able to debug.
A simplified diagram of some of the internal interface circuitry of the MPLAB PICkit 4 In-Circuit Debugger is shown.

**FIGURE 2-8: PROPER CONNECTIONS FOR PROGRAMMING**

For programming, no clock is needed on the target device, but power must be supplied. When programming, the debugger puts programming levels on VPP/MCLR, sends clock pulses on PGC and serial data via PGD. To verify that the part has been programmed correctly, clocks are sent to PGC and data is read back from PGD. This sequence confirms the debugger and device are communicating correctly.

### 2.5 REQUIREMENTS FOR DEBUGGING

To debug (set breakpoints, see registers, etc.) with the MPLAB PICkit 4 In-Circuit Debugger system, there are critical elements that must be working correctly:

- The debugger must be connected to a computer. It must be powered by the computer via the USB cable and it must be communicating with the MPLAB X IDE software via the Micro-B USB cable. See Section 3.3 “Debug Tutorial” for details.

- The debugger must be connected as shown in Figure 2-8 to the Vpp, PGC and PGD pins of the target device with the modular interface cable (or equivalent).

- The target device must have power and a functional, running oscillator. If the target device does not run, for any reason, the MPLAB PICkit 4 In-Circuit Debugger cannot debug.

- The target device must have its configuration words programmed correctly. These are set using the MPLAB X IDE.
  - The oscillator Configuration bits should correspond to RC, XT, etc., depending upon the target design.
  - For some devices, the Watchdog Timer is enabled by default and needs to be disabled.
  - The target device must not have code protection enabled.
  - The target device must not have table read protection enabled.
  - For some devices with more than one PGC/PGD pair, the correct pair needs to be selected in the device’s configuration word settings. This only refers to debugging, since programming will work through any PGC/PGD pair.

When the conditions listed above are met, you may proceed to the following:

- Sequence of Operations Leading to Debugging
- Debugging Details
2.5.1 Sequence of Operations Leading to Debugging

Given that the Requirements for Debugging are met, set the MPLAB PICkit 4 In-Circuit Debugger as the current tool in MPLAB X IDE. Go to File>Project Properties to open the dialog, then under “Hardware Tool,” click PICkit 4. The following actions can now be performed.

• When Debug>Debug Main Project is selected, the application code is programmed into the device’s memory via the ICSP protocol as described at the beginning of this section.

• A small “debug executive” program is loaded into the high area of program memory of the target device. Since the debug executive must reside in program memory, the application program must not use this reserved space. Some devices have special memory areas dedicated to the debug executive. Check your device data sheet for details.

• Special “in-circuit debug” registers in the target device are enabled by MPLAB X IDE. These allow the debug executive to be activated by the debugger. See Section 2.7 “Resources Used by the Debugger” for more information on device reserved resources.

• The target device is run in debug mode.

2.5.2 Debugging Details

Figure 2-9 illustrates the typical default ICSP configuration for the MPLAB PICkit 4 In-Circuit Debugger system when it is ready for debugging.

To find out whether an application program will run correctly, a breakpoint is typically set early in the program code. When a breakpoint is set from the user interface of MPLAB X IDE, the address of the breakpoint is stored in the special internal debug registers of the target device. Commands on PGC and PGD communicate directly to these registers to set the breakpoint address.

Next, the Debug>Debug Main Project function is usually selected in MPLAB X IDE. The debugger will then tell the debug executive to run. The target will start from the Reset vector and execute until the Program Counter reaches the breakpoint address that was stored previously in the internal debug registers.
After the instruction at the breakpoint address is executed, the in-circuit debug mechanism of the target device “fires” and transfers the device’s Program Counter to the debug executive (much like an interrupt) and the user’s application is effectively halted. The debugger communicates with the debug executive via PGC and PGD, gets the breakpoint status information and sends it back to MPLAB X IDE. MPLAB X IDE then sends a series of queries to the debugger to get information about the target device, such as file register contents and the state of the CPU. These queries are ultimately performed by the debug executive.

The debug executive runs just like an application in program memory. It uses some locations on the stack for its temporary variables. If the device does not run, for whatever reason, such as no oscillator, a faulty power supply connection, shorts on the target board, etc., then the debug executive cannot communicate to the MPLAB PICkit 4 In-Circuit Debugger and MPLAB X IDE will issue an error message.

Another way to get a breakpoint is to select Debug > Pause. This toggles the PGC and PGD lines so that the in-circuit debug mechanism of the target device switches the Program Counter from the user’s code in program memory to the debug executive. Again, the target application program is effectively halted, and MPLAB X IDE uses the debugger communications with the debug executive to interrogate the state of the target device.

### 2.6 PROGRAMMING

In MPLAB X IDE, use the MPLAB PICkit 4 as a programmer to program a non-ICE/-ICD device, i.e., a device not on a header board. Set the MPLAB PICkit 4 debugger as the current tool (click the Debug Tool PICkit 4 in the navigation window, then select File > Project Properties to open the dialog, then under “Hardware Tool,” click PICkit 4) to perform these actions:

- When the Run Main Project icon (see below) is selected, the application code is programmed into the device’s memory via the ICSP protocol. No clock is required while programming and all modes of the processor can be programmed, including code protect, Watchdog Timer enabled and table read protect.

**FIGURE 2-10: RUN MAIN PROJECT ICON**

- A small “program executive” program may be loaded into the high area of program memory for some target devices.
- Special “in-circuit debug” registers in the target device are disabled by MPLAB X IDE, along with all debug features. This means that a breakpoint cannot be set, and register contents cannot be seen or altered.
- The target device is run in Release mode. As a programmer, the debugger can only toggle the MCLR line to Reset and start the target.

The MPLAB PICkit 4 In-Circuit Debugger system programs the target using ICSP. VPP, PGC and PGD lines should be connected as described previously. No clock is required while programming, and all modes of the processor can be programmed, including code protection, Watchdog Timer and table read protection.

---

Note: For information on programming, refer to the MPLAB X IDE online Help.
2.7 RESOURCES USED BY THE DEBUGGER

For a complete list of resources used by the debugger for your device, see the online Help file in MPLAB X IDE for the MPLAB PICkit 4 In-Circuit Debugger. From the MPLAB X IDE “Learn & Discover” page, click on Users Guide & Release Notes, then click on link for the “Reserved Resources for MPLAB PICkit 4.”
Chapter 3. Debugger Usage

3.1 INTRODUCTION

How to install and setup the MPLAB PICkit 4 In-Circuit Debugger system is discussed in this section. For instructions on using MPLAB X IDE with the debugger, refer to the online Help accessible from the MPLAB X IDE main menu bar Help>Tool Help Contents>MPLAB X IDE Help.

- Installation and Setup
- Debug Tutorial
- Quick Debug/Program Reference
- Debugger Limitations
- Common Debug Features
- Connecting the Target Board
- Setting Up the Target Board
- Setting Up MPLAB X IDE
- Starting and Stopping Debugging
- Viewing Processor Memory and Files
- Breakpoints and Stopwatch

3.2 INSTALLATION AND SETUP

In MPLAB X IDE, refer to the Help file “Getting Started with MPLAB X IDE” for details on installing the IDE and setting up the debugger to work with it.

In summary:
1. Install MPLAB X IDE.
   Tutorial topics are available in the MPLAB X IDE online Help that is accessible from the main menu bar Help>Tool Help Contents>MPLAB X IDE Help>Tutorial.
2. Connect the MPLAB PICkit 4 to the computer and allow the default USB drivers to install. For more information on target connections (see Chapter 2. “Operation”).

   **Note:** The debugger can power a target board only up to 50 mA.

3. Select which language toolsuite/compiler you want to use for development and install it on your computer.
4. Launch MPLAB X IDE and open the online Help (Help>Tool Help Contents>MPLAB X IDE Help) for detailed instructions for the creating and setting up a new project and running and debugging code.
Items of note are:

1. Each debugger contains a unique identifier which, when first installed, will be recognized by the operating system, regardless of which computer USB port is used.

2. MPLAB X IDE operation connects to the hardware tool at runtime (Run or Debug Run). To always be connected to the hardware tool, see Tools>Options, Embedded button, Generic Settings tab, “Maintain active connection to hardware tool” check box.

3. Configuration bits can only be viewed in the Configuration Bits window. To set them in code, select Window>Target Memory Views. Then select “Configuration Bits” from the Memory drop list and select “Read/Write” from the Format drop list to enable access to the settings.

3.3 DEBUG TUTORIAL

Refer to the MPLAB X IDE Help file titled “Getting Started with MPLAB X IDE,” and navigate through the “Tutorial” to the “Running and Debugging Code.”

3.4 QUICK DEBUG/PROGRAM REFERENCE

The following table is a quick reference for using the MPLAB ICD 4 In-Circuit Debugger as either a debugging or programming tool.

**Note:** Headers are not supported at this time.

<table>
<thead>
<tr>
<th>TABLE 3-1: DEBUG VS. PROGRAM OPERATION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Item</strong></td>
</tr>
<tr>
<td>----------------------------------------</td>
</tr>
<tr>
<td>Needed Hardware</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>MPLAB X IDE selection</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Program Operation</td>
</tr>
<tr>
<td>Debug Features Available</td>
</tr>
<tr>
<td>Serial Quick-Time Programming (SQTP)</td>
</tr>
<tr>
<td>Command-line Operation</td>
</tr>
</tbody>
</table>
3.5 DEBUGGER LIMITATIONS

For a complete list of debugger limitations for your device, see the online Help file in MPLAB X IDE (Help> Tool Contents>Hardware Tool Reference>Limitations).

3.6 COMMON DEBUG FEATURES

Refer to the Help file “Getting Started with MPLAB X IDE,” Running and Debugging Code section, for details on debug features. This section includes:

1. Debug Running the project (build, program and run) from Debug>Debug Main Project.
2. Using breakpoints
3. Stepping through code
4. Using the Watches window
5. Viewing Memory, Variables and the Call Stack
6. Using the Call Graph

3.7 CONNECTING THE TARGET BOARD

1. Connect the Micro-B USB cable between the debugger and the computer, if not already connected.
2. Connect the appropriate cable(s) between the debugger to the target.
3. Connect power to the target if needed.

FIGURE 3-1: INSERT COMMUNICATIONS AND USB CABLES

See Section 2.2 “Debugger to Target Communication” for more details and a diagram.

3.8 SETTING UP THE TARGET BOARD

The target must be set up for the type of target device to be used.

3.8.1 Using Production Devices

For production devices, the debugger may be connected directly to the target board. The device on the target board must have built-in debug circuitry in order to debug with the MPLAB PICkit 4 In-Circuit Debugger.

The target board must have a connector to accommodate the communications chosen for the debugger. For connection information, see Section 2.2 “Debugger to Target Communication”.

3.8.2 Using ICE Devices

Note: Headers are not supported at this time.
For ICE devices, an ICE header board is required. The header board contains the hardware necessary to emulate a specific device or family of devices. For more information on ICE headers, see the “Processor Extension Pak and Header Specification” (DS50001292).

A transition socket is used with the ICE header to connect the header to the target board. Transition sockets are available in various styles to allow a common header to be connected to one of the supported surface mount package styles. For more information on transition sockets, see the “Transition Socket Specification” (DS50001194).

Header board layout will be different for headers or processor extension packs. For connection information, see Section 2.2 “Debugger to Target Communication”.

### 3.8.3 Using an ICD Header

| Note: | Headers are not supported at this time. |

All Baseline and some Mid-Range PIC microcontrollers require a special –ICD device mounted on a debug header circuit board to enable the debugging feature. For a list of these devices and the required ICD header board part number, please see the “Processor Extension Pak and Header Specification” (DS50001292).

Each ICD header board comes with the necessary – IC device and is used on the target board instead of the production microcontroller. However, most header boards have an RJ-11 debug connector which requires the AC164110 RJ-11 to ICSP™ adapter kit to connect it to MPLAB PICkit 4.

Many Mid-Range PIC microcontrollers and all PIC18 and 16-bit PIC microcontroller devices do not require an ICD header and can be debugged directly through the ICSP programming connections.

### 3.8.4 Powering the Target

These are configuration essentials:

- When using the USB connection, MPLAB PICkit 4 can be powered from the computer but it can only provide a limited amount of current, up to 50 mA, at VDD from 1.2-5V to a small target board.
- The desired method is for the target to provide VDD since it can provide a higher current. The additional benefit is that plug-and-play target detection facility is inherited, i.e., MPLAB X IDE will let you know in the Output window when it has detected the target and has detected the device.

If you have not already done so, connect the MPLAB PICkit 4 to the target using the appropriate cables (see Section 3.7 “Connecting the Target Board”). Then power the target.

### 3.9 SETTING UP MPLAB X IDE

Once the hardware is connected and powered, MPLAB X IDE may be set up for use with the MPLAB PICkit 4 in-circuit debugger.

On some devices, you must select the communications channel in the Configuration bits, e.g., PGC1/EMUC1 and PGD1/EMUD1. Make sure the pins selected here are the same ones physically connected to the device.

Refer to the MPLAB X IDE Help for details on installing the software and setting up the debugger to work with it.
3.10 STARTING AND STOPPING DEBUGGING

To debug an application in MPLAB X IDE, you must create a project that contains your source code so that the code may be built, programmed into your device, and executed as specified below:

- To run your code, select either Debug>Debug Main Project or from the Run toolbar.
- To halt your code, select either Debug>Pause or from the Debug toolbar.
- To run your code again, select either Debug>Continue or from the Debug toolbar.
- To step through your code, select either Debug>Step Into or from the Debug toolbar. Be careful not to step into a Sleep instruction or you will have to perform a processor Reset to resume emulation.
- To step over a line of code, select Debug>Step Over from the Debug toolbar.
- To end code execution, select either Debug>Finish Debugger Session or from the Debug toolbar.
- To perform a processor Reset on your code, select Debug>Reset from the Debug toolbar.

Additional Resets, such as POR/BOR, MCLR, and System, may be available, depending on the device. Refer to the product data sheet for more information.

3.11 VIEWING PROCESSOR MEMORY AND FILES

MPLAB X IDE provides several windows for viewing debug and memory information. These are selectable from the Window menu. See MPLAB X IDE online Help for more information on using these windows.

- Window>Target Memory Views - view data (Data Memory) and code (Execution Memory) in device memory. Other memory can also be viewed as defined by the device including Peripherals, Configuration Bits, CPU Registers, External EBI Memory, External SQI Memory, User ID Memory, etc.
- Window>Debugging - view debug information. Select from Variables, Watches, Call Stack, Breakpoints, Stopwatch, and many others.

To view your source code, find the source code file you wish to view in the Projects window and double-click to open it in a Files window. Code in this window is color-coded according to the processor and build tool that you have selected. To change the style of color-coding, select Tools>Options, Fonts & Colors, Syntax tab.

3.12 BREAKPOINTS AND STOPWATCH

Use breakpoints to halt code execution at specific lines in your code. Use the stopwatch with breakpoints to time code execution.

- Breakpoint Resources
- Hardware or Software Breakpoint Selection
- Breakpoint and Stopwatch Usage

3.12.1 Breakpoint Resources

In 16-bit devices, breakpoints, data captures, and runtime watches use the same resources. Therefore, the available number of breakpoints is actually the available number of combined breakpoints/triggers.
In 32-bit devices, breakpoints use different resources than data captures and runtime watches. Therefore, the available number of breakpoints is independent of the available number of triggers.

The number of hardware and software breakpoints available and/or used is displayed in the Dashboard window (Window>Dashboard). See the MPLAB X IDE online help for more on this feature. Not all devices have software breakpoints.

For limitations on breakpoint operation, including the general number of hardware breakpoints per device, and hardware breakpoint skidding amounts, see the online Help file in MPLAB X IDE for the debugger limitations (Help>Help Contents>Hardware Tool Reference>Limitations - Emulators and Debuggers).

### 3.12.2   Hardware or Software Breakpoint Selection

To select hardware or software breakpoints:

1. Select your project in the Projects window. Then, select File>Project Properties or right click and select "Properties."
2. In the Project Properties dialog, select “PICkit 4” under “Categories.”
3. Under "Option Categories,” select “Debug Options.”
4. Check “Use software breakpoints” to use software breakpoints. Uncheck to use hardware breakpoints.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Hardware Breakpoints</th>
<th>Software Breakpoints</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of breakpoints</td>
<td>Limited</td>
<td>Unlimited</td>
</tr>
<tr>
<td>Breakpoints written to*</td>
<td>Internal Debug Registers</td>
<td>Flash Program Memory</td>
</tr>
<tr>
<td>Breakpoints applied to**</td>
<td>Program Memory/Data Memory</td>
<td>Program Memory only</td>
</tr>
<tr>
<td>Time to set breakpoints</td>
<td>Minimal</td>
<td>Dependent on oscillator speed, time to program Flash Memory, and page size</td>
</tr>
<tr>
<td>Breakpoint skidding</td>
<td>Most devices. See the online Help, Limitations section, for details.</td>
<td>No</td>
</tr>
</tbody>
</table>

* Where information about the breakpoint is written in the device.

** What kind of device feature applies to the breakpoint. This is where the breakpoint is set.

To help you decide which type of breakpoints to use (hardware or software), the following table compares the features of each.

### 3.12.3   Breakpoint and Stopwatch Usage

Breakpoints halt execution of code. To determine the time between the breakpoints, use the stopwatch.

Refer to the MPLAB X IDE online Help for instructions on how to set up and use breakpoints and the stopwatch.
Part 2 – Troubleshooting

Chapter 4. Troubleshooting First Steps ........................................................................... 35
Chapter 5. Frequently Asked Questions (FAQs) .............................................................. 39
Chapter 6. Error Messages ............................................................................................ 41
Chapter 4. Troubleshooting First Steps

4.1 INTRODUCTION

If you are having problems with MPLAB PICkit 4 In-Circuit Debugger operation, start here.

- Some Questions to Answer First
- Top Reasons Why You Can’t Debug
- Other Things to Consider
  - General
  - How to Invoke the Bootloader Mode
  - How to Use the Hardware Tool Emergency Boot Firmware Recovery Utility

4.2 SOME QUESTIONS TO ANSWER FIRST

1. What device are you working with? Often an upgrade to a newer version of MPLAB X IDE is required to support newer devices.

2. Are you using a Microchip demo board or one of your own design? Have you followed the guidelines for resistors/capacitors for communications connections? See Chapter 2. “Operation”.

3. Have you powered the target? The debugger cannot power the target if greater than 50 mA. For applications needing more than 50 mA, use an external power supply to power the target board.

4. Are you using a USB hub in your set up? Is it powered? If you continue to have problems, try using the debugger without the hub (plugged directly into the computer.)

5. Are you using the USB cable shipped with the debugger? Other USB cables may be of poor quality, too long or do not support USB communication.

4.3 TOP REASONS WHY YOU CAN’T DEBUG

1. Oscillator not working. Check your Configuration bits setting for the oscillator. If you are using an external oscillator, try using an internal oscillator. If you are using an internal PLL, make sure your PLL settings are correct.

2. No power to the target board. Check the power cable connection.

3. Incorrect VDD voltage. The VDD voltage is outside the specifications for this device. See the device programming specification for details.

4. Physical disconnect. The debugger has become physically disconnected from the computer and/or the target board. Check the communications cables’ connections.

5. Communications lost. Debugger to PC communication has somehow been interrupted. Reconnect to the debugger in MPLAB X IDE.
6. **Device not seated.** The device is not properly seated on the target board. If the debugger is properly connected and the target board is powered, but the device is absent or not plugged in completely, you may get the following message:

   **Target Device ID (0x0) does not match expected Device ID (0x%x)**

   where %x is the expected device ID.

7. **Device is code-protected.** Check your Configuration bits settings for code protection.

8. **No device debug circuitry.** The production device may not have debugging capabilities. Use a debug header instead. (See the “Processor Extension Pak and Debug Header Specification” (DS50001292) in “Recommended Supplemental Reference.”)

9. **Application code corrupted.** The target application has become corrupted or contains errors. Try rebuilding and reprogramming the target application. Then initiate a Power-On-Reset of the target.

10. **Incorrect programming pins.** The PGC/PGD pin pairs are not correctly programmed in your Configuration bits (for devices with multiple PGC/PGD pin pairs).

11. **Additional setup required.** Other configuration settings are interfering with debugging. Any configuration setting that would prevent the target from executing code will also prevent the emulator from putting the code into Debug mode.

12. **Incorrect brown-out voltage.** Brown-out Detect voltage is greater than the operating voltage VDD. This means the device is in Reset and cannot be debugged.

13. **Incorrect connections.** Review the guidelines in Chapter 2. “Operation” for the correct communication connections.

14. **Invalid request.** The debugger cannot always perform the action requested. For example, the debugger cannot set a breakpoint if the target application is currently running.

### 4.4 OTHER THINGS TO CONSIDER

#### 4.4.1 General

1. It is possible the error was a one-time event. Try the operation again.

2. There may be a problem programming in general. As a test, switch to Run mode using the icon and program the target with the simplest application possible (e.g., a program to blink an LED). If the program will not run, then you know that something is wrong with the target setup.

3. It is possible that the target device has been damaged in some way (e.g., over current.) Development environments are notoriously hostile to components. Consider trying another target board.

4. Microchip Technology Inc. offers demonstration boards to support most of its microcontrollers. Consider using one of these applications, which are known to work, to verify correct MPLAB PICkit 4 In-Circuit Debugger functionality.

5. Review debugger setup to ensure proper application setup. For more information, see Chapter 2. “Operation”.

6. Your program speed may be set too high for your circuit. In MPLAB X IDE, go to `File>Project Properties`, select PICkit 4 in Categories, then Program Options in Option categories, Program Speed and select a slower speed from the drop-down menu. The default is Normal (see figure below).
7. There may be certain situations where the debugger is not operating properly and firmware may need to be downloaded or the debugger needs to be reprogrammed. See the following sections to determine additional actions.

4.4.2 How to Invoke the Bootloader Mode

If the MPLAB X IDE or MPLAB IPE cannot communicate with the debugger, the debugger may need to be forced into bootloader mode (download new firmware). Some possible reasons could be the following:

- If steps 1-5 in Section 4.4.1 “General” did not correct the debugger issue.
- If the MPLAB X IDE Output window shows an asterisk (*) next to the Application version number, the debugger’s firmware is not the newest.

This can occur if the Project Properties Firmware option has the “Use Latest Firmware” box unchecked and there is a new firmware version available with the MPLAB X IDE version.

In this case, check the “Use Latest Firmware” box and click the Refresh Debug Tool Status icon in the MPLAB X IDE dashboard display. If there is still an asterisk next to the Application version number, or the debugger issue is not resolved, proceed to the following steps for bootloader mode.

Also, refer to Section B.3.2 “Indicator Light Strip” for more information on light strip modes and bootloader errors.

Perform the following steps to force the debugger into bootloader mode:

1. Disconnect the Micro-B USB cable from the debugger.
2. Press down on the MPLAB PICKit 4 logo and hold while plugging in the Micro-B USB cable. The light strip flashes purple. Continue pressing the logo until the light strip stops flashing and changes to steady on purple. You are now in bootloader mode.
3. Try to reestablish communication with the MPLAB X IDE or MPLAB IPE. When successful, the firmware update is downloaded. When complete, the LED is steady on blue and the debugger is ready for operation.
4.4.3 How to Use the Hardware Tool Emergency Boot Firmware Recovery Utility

**WARNING**

Only use this utility to restore hardware tool boot firmware to its factory state. Use only if your hardware tool no longer functions on any machine.

The debugger may need to be forced into recovery boot mode (reprogrammed) in rare situations. For example, if any of the following occurs when the debugger is connected to the computer:

- If the debugger has no LED lit.
- If the procedure described in Section 4.4.2 “How to Invoke the Bootloader Mode” was not successful.

**YOU MUST USE MPLAB X IDE V4.15 OR GREATER TO USE THE EMERGENCY RECOVERY UTILITY.**

Carefully follow the instructions found in MPLAB X IDE under the main menu option Debug>Hardware Tool Emergency Boot Firmware Recovery.

**FIGURE 4-2: SELECTING EMERGENCY UTILITY**

![Image of selecting emergency utility](image)

**FIGURE 4-3: EMERGENCY RECOVERY BUTTON**

![Image of emergency recovery button](image)

If the procedure was successful, the recovery wizard displays a success screen. The MPLAB PICkit 4 will now be operational and able to communicate with the MPLAB X IDE.

If the procedure fails, try it again. If it fails a second time, contact Microchip Support at [http://support.microchip.com](http://support.microchip.com).
Chapter 5. Frequently Asked Questions (FAQs)

5.1 INTRODUCTION

Look here for answers to frequently asked questions about the MPLAB PICkit 4 In-Circuit Debugger system.

• How Does It Work
• What’s Wrong

5.2 HOW DOES IT WORK

• What’s in the silicon that allows it to communicate with the MPLAB PICkit 4 In-Circuit Debugger?
  MPLAB PICkit 4 In-Circuit Debugger can communicate with Flash silicon via the ICSP™ interface. It uses the debug executive downloaded into program or test memory.
• How is the throughput of the processor affected by having to run the debug executive?
  The debug executive doesn’t run while in Run mode, so there is no throughput reduction when running your code, i.e., the debugger doesn’t ‘steal’ any cycles from the target device.
• Does the MPLAB PICkit 4 In-Circuit Debugger have complex breakpoints like other in-circuit emulators/debuggers?
  No. But you can break based on a value in a data memory location or program address.
• Is the MPLAB PICkit 4 optoisolated or electrically isolated?
  No. You cannot apply a floating or high voltage (120V) to the current system.
• Will the MPLAB PICkit 4 slow down the running of the program?
  No. The device will run at any device speed as specified in the data sheet.
• Is it possible to debug a dsPIC DSC running at any speed?
  The MPLAB PICkit 4 is capable of debugging at any device speed as specified in the device’s data sheet.

5.3 WHAT’S WRONG

• Performing a Verify fails after programming the device. Is this a programming issue?
  If Run Main Project icon ( ) is selected, the device will automatically run immediately after programming. Therefore, if your code changes the flash memory, verification could fail. To prevent the code from running after programming, select ‘Hold in Reset’.
• My computer went into power-down/hibernate mode, and now my debugger won’t work. What happened?

When using the debugger for prolonged periods of time, and especially as a debugger, be sure to disable the Hibernate mode in the Power Options Dialog window of your computer’s operating system. Go to the Hibernate tab and clear or uncheck the “Enable hibernation” check box. This will ensure that all communication is maintained across all the USB subsystem components.

• I set my peripheral to NOT freeze on halt, but it is suddenly freezing. What’s going on?

For dsPIC30F/33F and PIC24F/H devices, a reserved bit in the peripheral control register (usually either bit 14 or 5) is used as a Freeze bit by the debugger. If you have performed a write to the entire register, you may have overwitten this bit. (The bit is user-accessible in Debug mode.)

To avoid this problem, write only to the bits you wish to change for your application (BTS, BTC) instead of to the entire register (MOV).

• When using a 16-bit device, an unexpected reset occurred. How do I determine what caused it?

Some things to consider:
- To determine a reset source, check the RCON register.
- Handle traps/interrupts in an Interrupt Service Routine (ISR). You should include trap.c style code, i.e.,
  
  void __attribute__((__interrupt__)) _OscillatorFail(void) {
    INTCON1bits.OSCFAIL = 0;        //Clear the trap flag
    while (1);
  }
  
  void __attribute__((__interrupt__)) _AltOscillatorFail(void) {
    INTCON1bits.OSCFAIL = 0;        //Clear the trap flag
    while (1);
  }

  void __attribute__((__interrupt__)) _OscillatorFail(void) {
    INTCON1bits.OSCFAIL = 0;        //Clear the trap flag
    while (1);
  }

  void __attribute__((__interrupt__)) _AltOscillatorFail(void) {
    INTCON1bits.OSCFAIL = 0;        //Clear the trap flag
    while (1);
  }

  void __attribute__((__interrupt__)) _OscillatorFail(void) {
    INTCON1bits.OSCFAIL = 0;        //Clear the trap flag
    while (1);
  }

  void __attribute__((__interrupt__)) _AltOscillatorFail(void) {
    INTCON1bits.OSCFAIL = 0;        //Clear the trap flag
    while (1);
  }

- Use ASSERTs.
Chapter 6. Error Messages

6.1 INTRODUCTION
The MPLAB PICkit 4 In-Circuit Debugger produces many different error messages; some are specific and others can be resolved with general corrective actions. In general, read any instructions under your error message. If these fail to fix the problem or if there are no instructions, refer to the following sections.

- Types of Error Messages
- General Corrective Actions

6.2 TYPES OF ERROR MESSAGES

6.2.1 Debugger-to-Target Communication Errors
Failed to send database
If you receive this error:
1. Try downloading again. It may be a one-time error.
2. Try manually downloading the highest-number .jam file.
If these fail to fix the problem or if there are no instructions, see Section 6.3.2 “Debugger-to-Target Communication Error Actions”.

6.2.2 Corrupted/Outdated Installation Errors
Failed to download firmware
If the Hex file exists:
- Reconnect and try again.
- If this does not work, the file may be corrupted. Reinstall MPLAB X IDE.
If the Hex file does not exist:
- Reinstall MPLAB X IDE.

Unable to download debug executive
If you receive this error while attempting to debug:
1. Deselect the debugger as the debug tool.
2. Close your project and then close MPLAB X IDE.
3. Restart MPLAB X IDE and re-open your project.
4. Reselect the debugger as your debug tool and attempt to program your target device again.
Unable to download program executive
If you receive this error while attempting to program:
1. Deselect the debugger as the programmer.
2. Close your project and then close MPLAB X IDE.
3. Restart MPLAB X IDE and re-open your project.
4. Reselect the debugger as your programmer and attempt to program your target device again.
If these fail to fix the problem or if there are no instructions, see Section 6.3.4 “Corrupted Installation Actions”.

6.2.3 Debug Failure Errors
The target device is not ready for debugging. Please check your configuration bit settings and program the device before proceeding.
You will receive this message when you have not programmed your device for the first time and try to Run. If you receive this message after this, or immediately after programming your device, please refer to Section 6.3.6 “Debug Failure Actions”.
The device is code protected.
The device on which you are attempting to operate (read, program, blank check or verify) is code protected, i.e., the code cannot be read or modified. Configuration bits setting for code protection (Windows>Target Memory Views>Configuration Bits).
Disable code protection, set or clear the appropriate Configuration bits in code or in the Configuration Bits window according to the device data sheet. Then erase and reprogram the entire device.
If these actions fail to fix the problem, see Section 6.3.2 “Debugger-to-Target Communication Error Actions” and Section 6.3.6 “Debug Failure Actions”.

6.2.4 Miscellaneous Errors
MPLAB PICkit 4 is busy. Please wait for the current operation to finish.
If you receive this error when attempting to deselect the debugger as a debugger or programmer:
1. Wait - give the debugger time to finish any application tasks. Then try to deselect the debugger again.
2. Select (Finish Debugger Session) to stop any running applications. Then, try to deselect the debugger again.
3. Unplug the debugger from the computer. Then try to deselect the debugger again.
4. Shut down MPLAB X IDE.
6.2.5 List of Error Messages

### TABLE 6-1: ALPHABETIZED LIST OF ERROR MESSAGES

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AP_VER=Algorithm Plugin Version</td>
<td></td>
</tr>
<tr>
<td>AREAS_TO_PROGRAM=The following memory area(s) will be programmed:</td>
<td></td>
</tr>
<tr>
<td>AREAS_TO_READ=The following memory area(s) will be read:</td>
<td></td>
</tr>
<tr>
<td>AREAS_TO_VERIFY=The following memory area(s) will be verified:</td>
<td></td>
</tr>
<tr>
<td>BLANK_CHECK_COMPLETE=Blank check complete, device is blank.</td>
<td></td>
</tr>
<tr>
<td>BLANK_CHECK_FAILED=Blank check failed. The device is not blank</td>
<td></td>
</tr>
<tr>
<td>BLANK_CHECKING=Blank Checking...</td>
<td></td>
</tr>
<tr>
<td>BOOT_CONFIG_MEMORY=boot config memory</td>
<td></td>
</tr>
<tr>
<td>BOOT_VER=Boot Version</td>
<td></td>
</tr>
<tr>
<td>BOOTFLASH=boot flash</td>
<td></td>
</tr>
<tr>
<td>BP_CANT_B_DELETED_WHEN_RUNNING=software breakpoints cannot be removed while the target is running. The selected breakpoint will be removed the next time the target halts.</td>
<td></td>
</tr>
<tr>
<td>CANT_CREATE_CONTROLLER=Unable to find the tool controller class.</td>
<td></td>
</tr>
<tr>
<td>CANT_FIND_FILE=Unable to locate file %.s.</td>
<td></td>
</tr>
<tr>
<td>CANT_OP_BELOW_LVPTHRESH=The voltage level selected %f, is below the minimum erase voltage of %f. The operation cannot continue at this voltage level.</td>
<td></td>
</tr>
<tr>
<td>CANT_PGM_USEROTP=The debug tool cannot program User OTP memory because it is not blank. Please exclude User OTP memory from the memories to program or switch to a device with blank User OTP memory.</td>
<td></td>
</tr>
<tr>
<td>CANT_PRESERVE_PGM_MEM=Unable to preserve program memory: Invalid range Start = %08x, End = %08x.</td>
<td></td>
</tr>
<tr>
<td>CANT_READ_REGISTERS=Unable to read target register(s).</td>
<td></td>
</tr>
<tr>
<td>CANT_READ_SERIALNUM=Unable to read the device serial number.</td>
<td></td>
</tr>
<tr>
<td>CANT_REGISTER_ALTERNATE_PNP=Unable to register for PNP events for multiple USB product Ids.</td>
<td></td>
</tr>
<tr>
<td>CANT_REMOVE_SWPS_BUSY=The PICkit 4 is currently busy and cannot remove software breakpoints at this time.</td>
<td></td>
</tr>
<tr>
<td>CHECK_4_HIGH_VOLTAGE_VPP=CAUTION: Check that the device selected in MPLAB IDE (%s) is the same one that is physically attached to the debug tool. Selecting a 5V device when a 3.3V device is connected can result in damage to the device when the debugger checks the device ID. Do you wish to continue?</td>
<td></td>
</tr>
<tr>
<td>CHECK_PGM_SPEED=You have set the program speed to %s. The circuit on your board may require you to slow the speed down. Please change the setting in the tool properties to low and try the operation again.</td>
<td></td>
</tr>
<tr>
<td>CHECK_SLAVE_DEBUG=Debugging may have failed because the, &quot;Debug&quot; check box in the Slave Core settings of the master project has not been enabled. Please make sure this setting is enabled.</td>
<td></td>
</tr>
<tr>
<td>COMM_PROTOCOL_ERROR=A communication error with the debug tool has occurred. The tool will attempt to recover momentarily.</td>
<td></td>
</tr>
<tr>
<td>COMMAND_TIME_OUT=PICKit 4 has timeout out waiting for a response to command %02x.</td>
<td></td>
</tr>
<tr>
<td>CONFIG_BITS_MASKS=CfgRequiredBitsMask Values:</td>
<td></td>
</tr>
<tr>
<td>CONFIGURATION=configuration</td>
<td></td>
</tr>
<tr>
<td>CONFIGURATION_MEMORY=configuration memory</td>
<td></td>
</tr>
<tr>
<td>CONNECTING_TO=Connecting to MPLAB PICkit 4</td>
<td></td>
</tr>
<tr>
<td>CONNECTION_FAILED=Connection Failed.</td>
<td></td>
</tr>
<tr>
<td>CORRUPTED_STREAMING_DATA=Invalid streaming data has been detected. Run time watch or trace data may no longer be valid. It is recommended that you restart your debug session.</td>
<td></td>
</tr>
<tr>
<td>CPM_TO_TARGET_FAILED=An exception occurred during ControlPointMediator.ToTarget().</td>
<td></td>
</tr>
<tr>
<td>DATA_FLASH_MEMORY=Data Flash memory</td>
<td></td>
</tr>
<tr>
<td>DATA_FLASH=data flash</td>
<td></td>
</tr>
<tr>
<td>DEBUG_INFO_PGM_FAILED=Could not enter debug mode because programming the debug information failed. Invalid combinations of config bits may cause this problem</td>
<td></td>
</tr>
</tbody>
</table>
### TABLE 6-1: ALPHABETIZED LIST OF ERROR MESSAGES (CONTINUED)

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DEBUG_READ_INFO</td>
<td>Reading the device while in debug mode may take a long time due to the target oscillator speed. Reducing the range that you'd like to read (under the PICKit 4 project properties) can mitigate the situation. The abort operation can be used to terminate the read operation if necessary.</td>
</tr>
<tr>
<td>DEVICE_ID_REVISION</td>
<td>Device Id Revision</td>
</tr>
<tr>
<td>DEVICE_ID</td>
<td>Device Id</td>
</tr>
<tr>
<td>DEVICE_INFO_CONFIG_BITS_MASK</td>
<td>Address = %08x, Mask = %08x</td>
</tr>
<tr>
<td>DEVICE_INFO_MEMBERS</td>
<td>DeviceInfo: pcAddress = %08x, Vpp = %.2f, useRowEraseIfVoltageIsLow = %s, voltageBelowWhichUseRowErase = %.2f, deviceName = %s, programmerType = %s</td>
</tr>
<tr>
<td>DEVICE_INFO_MEMINFO_MEMBERS</td>
<td>DeviceInfo: mask = %04x, exists = %s, startAddr = %08x, endAddr = %08x, rowSize = %04x, rowEraseSize = %04x, addrInc = %04x, widthProgram = %04x</td>
</tr>
<tr>
<td>DEVICE_INFO</td>
<td>DeviceInfo: Values:</td>
</tr>
<tr>
<td>DEVID_MISMATCH</td>
<td>Target Device ID (0x%x) is an Invalid Device ID. Please check your connections to the Target Device.</td>
</tr>
<tr>
<td>DFU_NOT_SUPPORTED</td>
<td>MPLAB X has detected the tool connected has capabilities that this version does not support. Please download the latest version of MPLAB X to use this tool.</td>
</tr>
<tr>
<td>DISCONNECT_WHILE_BUSY</td>
<td>The tool was disconnected while it was busy.</td>
</tr>
<tr>
<td>EEDATA_MEMORY</td>
<td>EEData memory</td>
</tr>
<tr>
<td>EEDATA</td>
<td>EEData</td>
</tr>
<tr>
<td>EMPTY_PROGRAM_RANGES</td>
<td>The programming operation did not complete because no memory areas have been selected.</td>
</tr>
<tr>
<td>EMULATION_MEMORY_READ_WRITE_ERROR</td>
<td>An error occurred while trying to read/write MPLAB's emulation memory: Address=%08x</td>
</tr>
<tr>
<td>END</td>
<td>end</td>
</tr>
<tr>
<td>ENSURE_SELF_TEST_READY</td>
<td>Please ensure the RJ-11 cable is connected to the test board before continuing. Would you like to continue?</td>
</tr>
<tr>
<td>ENV_ID_GROUP</td>
<td>Device Identification</td>
</tr>
<tr>
<td>ERASE_COMPLETE</td>
<td>Erase successful</td>
</tr>
<tr>
<td>ERASING</td>
<td>Erasing...</td>
</tr>
<tr>
<td>FAILED_2_PGM_DEVICE</td>
<td>Failed to program device</td>
</tr>
<tr>
<td>FAILED_CREATING_COM</td>
<td>Unable create communications object (RI4Com).</td>
</tr>
<tr>
<td>FAILED_CREATING_DEBUGGER_MODULES</td>
<td>Initialization failed: Failed creating the debugger module</td>
</tr>
<tr>
<td>FAILED_ERASING</td>
<td>Failed to erase the device</td>
</tr>
<tr>
<td>FAILED_ESTABLISHING_COMMUNICATION</td>
<td>Unable to establish tool communications</td>
</tr>
<tr>
<td>FAILED_GETTING_DBG_EXEC</td>
<td>A problem occurred while trying to load the debug executive.</td>
</tr>
<tr>
<td>FAILED_GETTING_DEVICE_INFO</td>
<td>Initialization failed: Failed while retrieving device database (.pic) information</td>
</tr>
<tr>
<td>FAILED_GETTING_EMU_INFO</td>
<td>Initialization failed: Failed getting emulation database information</td>
</tr>
<tr>
<td>FAILED_GETTING_HEADER_INFO</td>
<td>Initialization failed: Failed getting header database information</td>
</tr>
<tr>
<td>FAILED_GETTING_PGM_EXEC</td>
<td>A problem occurred while trying to load the program executive.</td>
</tr>
<tr>
<td>FAILED_GETTING_TEX</td>
<td>Unable to obtain the ToolExecMediator</td>
</tr>
<tr>
<td>FAILED_GETTING_TOOL_INFO</td>
<td>Initialization failed: Failed while retrieving tool database (.ri4) information</td>
</tr>
<tr>
<td>FAILED_INITING_DATABASE</td>
<td>Initialization failed: Unable to initialize the too database object</td>
</tr>
<tr>
<td>FAILED_INITING_DEBUGHANDLER</td>
<td>Initialization failed: Unable to initialize the DebugHandler object</td>
</tr>
<tr>
<td>FAILED_PARSING_FILE</td>
<td>Failed to parse firmware file: %s</td>
</tr>
<tr>
<td>FAILED_READING_EMULATION_REGS</td>
<td>Failed to read emulation memory.</td>
</tr>
<tr>
<td>FAILED_READING_MPLAB_MEMORY</td>
<td>Unable to read %s memory from %0x08 to %0x08.</td>
</tr>
<tr>
<td>FAILED_READING_SECURE_SEGMENT</td>
<td>A failure occurred while reading secure segment configuration bits</td>
</tr>
<tr>
<td>FAILED_SETTING_PC</td>
<td>Unable to set PC.</td>
</tr>
</tbody>
</table>
# Error Messages

**TABLE 6-1: ALPHABETIZED LIST OF ERROR MESSAGES (CONTINUED)**

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FAILED_SETTING_SHADOWS=Failed to properly set shadow registers.</td>
<td></td>
</tr>
<tr>
<td>FAILED_SETTING_XMIT_EVENTS=Unable to synchronize run time data semaphores.</td>
<td></td>
</tr>
<tr>
<td>FAILED_STEPING=Failed while stepping the target.</td>
<td></td>
</tr>
<tr>
<td>FAILED_TO_GET_DEVID=Failed to get Device ID. Please make sure the target device is attached and try the operation again.</td>
<td></td>
</tr>
<tr>
<td>FAILED_TO_INIT_TOOL=Failed to initialize PICKit 4</td>
<td></td>
</tr>
</tbody>
</table>
| FAILED_UPDATING_BP=Failed to update breakpoint:
File: %s
address: %08x |                                                                                   |
<p>| FAILED_UPDATING_FIRMWARE=Failed to properly update the firmware. |                                                                                   |
| FILE_REGISTER=file register                         |                                                                                   |
| FIRMWARE_DOWNLOAD_TIMEOUT=PICKit 4 timeout out during the firmware download process. |                                                                                   |
| FLASH_DATA_MEMORY=Flash data memory                 |                                                                                   |
| FLASH_DATA=flash data                               |                                                                                   |
| FRCINDEBUG_NEEDS_CLOCKSWITCHING=To use FRC in debug mode the clock switching configuration bits setting must be enabled. Please enable clock switching and retry the requested operation. |                                                                                   |
| FW_DOESNT_SUPPORT_DYNBP=The current PICKit 4 firmware does not support setting run time breakpoints for the selected device. Please download firmware version %02x.%02x.%02x or higher. |                                                                                   |
| GOOD_ID_MISMATCH=Target Device ID (0x%x) is a valid Device ID but does not match the expected Device ID (0x%x) as selected. |                                                                                   |
| HALTING=Halting...                                  |                                                                                   |
| HIGH=High                                           |                                                                                   |
| HOLDMCLR_FAILED=Hold in reset failed.               |                                                                                   |
| IDS_SELF_TEST_BOARD_PASSED=PICKit 4 is functioning properly. If you are still having problems with your target circuit please check the Target Board Considerations section of the online help. |                                                                                   |
| IDS_ST_CLKREAD_ERR=Test interface PGC clock line read failure. |                                                                                   |
| IDS_ST_CLKREAD_NO_TEST=Test interface PGC clock line read not tested. |                                                                                   |
| IDS_ST_CLKREAD_SUCCESS=Test interface PGC clock line read succeeded. |                                                                                   |
| IDS_ST_CLKWRITE_ERR=Test interface PGC clock line write failure. Please ensure that the tester is properly connected. |                                                                                   |
| IDS_ST_CLKWRITE_NO_TEST=Test interface PGC clock line write not tested. |                                                                                   |
| IDS_ST_CLKWRITE_SUCCESS=Test interface PGC clock line write succeeded. |                                                                                   |
| IDS_ST_DATREAD_ERR=Test interface PGD data line read failure. |                                                                                   |
| IDS_ST_DATREAD_NO_TEST=Test interface PGD data line read not tested. |                                                                                   |
| IDS_ST_DATREAD_SUCCESS=Test interface PGD data line read succeeded. |                                                                                   |
| IDS_ST_DATWRITE_ERR=Test interface PGD data line write failure. |                                                                                   |
| IDS_ST_DATWRITE_NO_TEST=Test interface PGD data line write not tested. |                                                                                   |
| IDS_ST_DATWRITE_SUCCESS=Test interface PGD data line write succeeded. |                                                                                   |
| IDS_ST_LVP_ERR=Test interface LVP control line failure. |                                                                                   |
| IDS_ST_LVP_NO_TEST=Test interface LVP control line not tested. |                                                                                   |
| IDS_ST_LVP_SUCCESS=Test interface LVP control line test succeeded. |                                                                                   |
| IDS_ST_MCLR_ERR=Test interface MCLR level failure. |                                                                                   |
| IDS_ST_MCLR_NO_TEST=Test interface MCLR level not tested. |                                                                                   |
| IDS_ST_MCLR_SUCCESS=Test interface MCLR level test succeeded. |                                                                                   |
| IDS_TEST_NOT_COMPLETED=Interface test could not be completed. Please contact your local FAE/CAE to SAR the unit. |                                                                                   |
| INCOMPATIBLE_FW=The PICKit 4 firmware in not compatible with the current version of MPLAB X software. |                                                                                   |
| INVALID_ADDRESS=The operation cannot proceed because the %s address is outside the devices address range of 0x%08x - 0x%08x. |                                                                                   |</p>
<table>
<thead>
<tr>
<th>JTAG_NEEDS_JTAGEN=The JTAG Adapter requires the JTAG enable configuration bit to be turned on. Please enable this configuration bit before continuing.</th>
</tr>
</thead>
<tbody>
<tr>
<td>MCLR_HOLD_RESET_NO_MAINTAIN_POWER=WARNING: You are powering the target device from PICkit 4 and have not selected the, &quot;Maintain active power&quot; option on the PICkit 4's Power property page. Without this option, the state of MCLR (hold/release from reset) cannot be guaranteed after the current session has ended.</td>
</tr>
<tr>
<td>MCLR_OFF_ID_WARNING=If you are using low voltage programming and the MCLRE config bit on the target device is set to OFF, this may explain why the device ID is incorrect. In this case, please switch to the, &quot;Use high voltage programming mode entry&quot; Program mode entry setting on the PICkit 4 Program Options property page and try the operation again.</td>
</tr>
<tr>
<td>MCLR_OFF_WARNING=If you wish to continue with MCLRE configuration bit set to OFF, switch to the, &quot;Use high voltage programming mode entry&quot; Program mode entry setting on the PICkit 4 Program Options property page</td>
</tr>
<tr>
<td>MEM_INFO=DeviceInfo: MemInfo values:</td>
</tr>
<tr>
<td>MEM_RANGE_ERROR_BAD_END_ADDR=Invalid program range end address %s received. Please check the manual program ranges on the debug tool's, &quot;Memories to Program&quot; property page.</td>
</tr>
<tr>
<td>MEM_RANGE_ERROR_BAD_START_ADDR=Invalid program range start address %s received. Please check the manual program ranges on the debug tool's, &quot;Memories to Program&quot; property page.</td>
</tr>
<tr>
<td>MEM_RANGE_ERROR_END_LESS_THAN_START=Invalid program range received: end address %s &lt; start address %s. Please check the manual program ranges on the debug tool's, &quot;Memories to Program&quot; property page.</td>
</tr>
<tr>
<td>MEM_RANGE_ERROR_ENDADDR_NOTAligned=Invalid program range received: end address %s is not aligned on a proper 0x%x address boundary. Please check the manual program ranges on the debug tool's, &quot;Memories to Program&quot; property page.</td>
</tr>
<tr>
<td>MEM_RANGE_ERROR_STARTADDR_NOTAligned=Invalid program range received: start address %s is not aligned on a proper 0x%x address boundary. Please check the manual program ranges on the debug tool's, &quot;Memories to Program&quot; property page.</td>
</tr>
<tr>
<td>MEM_RANGE_ERROR_UNKNOWN=An unknown error has occurred while trying to validate the user entered memory ranges.</td>
</tr>
<tr>
<td>MEM_RANGE_ERROR_WRONG_DATABASE=Unable to access data object while validating user entered memory ranges.</td>
</tr>
<tr>
<td>MEM_RANGE_OUT_OF_BOUNDS=The selected program range, %s, does not fall within the proper range for the memory area selected. Please check the manual program ranges on the debug tool's, &quot;Memories to Program&quot; property page.</td>
</tr>
<tr>
<td>MEM_RANGE_STRING_MALFORMED=The memory range(s) entered on the, &quot;Memories to Program&quot; property page (%s) is not formatted properly.</td>
</tr>
<tr>
<td>MISSING_BOOT_CONFIG_PARAMETER=Unable to find boot config start/end address in database.</td>
</tr>
</tbody>
</table>
| MUST_NOT_USE_LVP_WHEN_LVPCFG_OFF=MPLAB has detected that the low voltage configuration bit on the device is off and you have selected the low voltage programming option on the debug tool's property page. If you wish to use the low voltage programming option you must first do the following:
* Turn off the low voltage programming option on the debug tool's Program Options property page
* Program the low voltage configuration bit to on
* Turn on the low voltage programming option on the debug tool's Program Options property page |
| MUST_SET_LVPBIT_WITH_LVP=The low voltage programming feature requires the LVP configuration bit to be enabled on the target device. Please enable this configuration bit and try the operation again. |
| NEW_FIRMWARE_NO DEVICE=Downloading firmware |
| NEW_FIRMWARE=Now Downloading new Firmware for target device: %s |
| NMMR=NMMR |
| NO_DYNAMIC_BP_SUPPORT_AT_ALL=The current device does not support the ability to set breakpoints while the devices is running. The breakpoint will be applied prior to the next time you run the device. |
| NO_PGM_HANDLER=Cannot program software breakpoints. The program handler has not been initialized. |
| NO_PROGRAMMING_ATTEMPTED=MPLAB's memory is blank so no programming operation was attempted |
| NORMAL=Normal |
| OP_FAILED_FROM_CP=The requested operation failed because the device is code protected. |

OpenIDE-Module-Name=PICKit 4
OpenIDE-Module-Name=PICKit 4
TABLE 6-1: ALPHABETIZED LIST OF ERROR MESSAGES (CONTINUED)

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPERATION_INFO_MEMBERS=OperationInfo: Type = %s, Mask = %08x, Erase = %s, Production Mode = %s</td>
<td></td>
</tr>
<tr>
<td>OPERATION_INFO_TRANSFER_INFO_MEMBERS=OperationInfo: Start = %x, End = %x, Buffer Length = %d, Type = %s, Mask = %08x</td>
<td></td>
</tr>
<tr>
<td>OPERATION_INFO=OperationInfo: Values:</td>
<td></td>
</tr>
<tr>
<td>OPERATION_NOT_SUPPORTED=This operation is not supported for the selected device</td>
<td></td>
</tr>
<tr>
<td>OUTPUTWIN_TITLE=PICKit 4</td>
<td></td>
</tr>
<tr>
<td>PERIPHERAL=Peripheral</td>
<td></td>
</tr>
<tr>
<td>POWER_ERROR_NO_9V=The configuration is set for the tool to provide power to the target but 9V is not detected at the 9V power jack. Please ensure the external 9V power supply adapter is connected to the tool.</td>
<td></td>
</tr>
<tr>
<td>POWER_ERROR_NO_POWER_SRC=The configuration is set for the target board to supply its own power but no voltage has been detected on VDD. Please ensure you have your target powered up and try again.</td>
<td></td>
</tr>
<tr>
<td>POWER_ERROR_POWER_SRC_CONFLICT=The configuration is set for the tool to provide power to the target but there is voltage already detected on VDD. This is a conflict. Please ensure your target is not supplying voltage to the tool and try again.</td>
<td></td>
</tr>
<tr>
<td>POWER_ERROR_SLOW_DISCHARGE=We have detected some residual VDD voltage at the connector interface.</td>
<td></td>
</tr>
<tr>
<td>POWER_ERROR_VDD_TOO_HIGH=The VDD voltage desired is out of range. It exceeds the maximum voltage of 5.5V.</td>
<td></td>
</tr>
<tr>
<td>POWER_ERROR_VDD_TOO_LOW=The VDD voltage desired is out of range. It is below the minimum voltage of 1.5V.</td>
<td></td>
</tr>
<tr>
<td>POWER_ERROR_VPP_TOO_HIGH=The VPP voltage desired is out of range. It exceeds the maximum voltage of 14.2V.</td>
<td></td>
</tr>
<tr>
<td>POWER_ERROR_VPP_TOO_LOW=The VPP voltage desired is out of range. It is below the minimum voltage of 1.5V.</td>
<td></td>
</tr>
<tr>
<td>PRESERVE_MEM_RANGE_ERROR_BAD_END_ADDR=Invalid preserve range end address %s received. Please check the manual program ranges on the debug tool's, &quot;Memories to Program&quot; property page.</td>
<td></td>
</tr>
<tr>
<td>PRESERVE_MEM_RANGE_ERROR_BAD_START_ADDR=Invalid preserve range start address %s received. Please check the manual program ranges on the debug tool's, &quot;Memories to Program&quot; property page.</td>
<td></td>
</tr>
<tr>
<td>PRESERVE_MEM_RANGE_ERROR_END_LESSTHAN_START=Invalid preserve range received: end address %s &lt; start address %s. Please check the manual program ranges on the debug tool's, &quot;Memories to Program&quot; property page.</td>
<td></td>
</tr>
<tr>
<td>PRESERVE_MEM_RANGE_ERROR_ENDADDR_NOT_ALIGNED=Invalid preserve range received: end address %s is not aligned on a proper 0x%x address boundary. Please check the manual program ranges on the debug tool's, &quot;Memories to Program&quot; property page.</td>
<td></td>
</tr>
<tr>
<td>PRESERVE_MEM_RANGE_ERROR_STARTADDR_NOT_ALIGNED=Invalid preserve range received: start address %s is not aligned on a proper 0x%x address boundary. Please check the manual program ranges on the debug tool's, &quot;Memories to Program&quot; property page.</td>
<td></td>
</tr>
<tr>
<td>PRESERVE_MEM_RANGE_ERROR_UNKNOWN=An unknown error has occurred while trying to validate the user entered preserve ranges.</td>
<td></td>
</tr>
<tr>
<td>PRESERVE_MEM_RANGE_ERROR_WRONG_DATABASE=Unable to access data object while validating user entered memory ranges.</td>
<td></td>
</tr>
<tr>
<td>PRESERVE_MEM_RANGE_MEM_NOT_SELECTED=You have selected to preserve an area of memory but have not selected to program that area. Please check the preserved ranges on the debug tool's, &quot;Memories to Program&quot; property page, and make sure that any preserved memory is also designated to be programmed.</td>
<td></td>
</tr>
<tr>
<td>PRESERVE_MEM_RANGE_OUT_OF_BOUNDS=The selected preserve range, %s, does not fall within the proper range for the memory area selected. Please check the manual program ranges on the debug tool's, &quot;Memories to Program&quot; property page.</td>
<td></td>
</tr>
<tr>
<td>PRESERVE_MEM_RANGE_STRING_MALFORMED=The preserve memory range(s) entered on the, &quot;Memories to Program&quot; property page (%%s) is not formatted properly.</td>
<td></td>
</tr>
<tr>
<td>PRESERVE_MEM_RANGE_STRING_MALFORMED=The preserve memory range(s) entered on the, &quot;Memories to Program&quot; property page (%%s) is not formatted properly.</td>
<td></td>
</tr>
</tbody>
</table>
### TABLE 6-1: ALPHABETIZED LIST OF ERROR MESSAGES (CONTINUED)

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRESERVE_MEM_RANGE_WONT_BE_PROGRAMMED_AUTO_SELECT</td>
<td>Some or all of the preserve memory ranges (%) entered on the &quot;Memories to Program&quot; property page, do not fall under the indicated program range(s) (%) for the memory selected. Please deselect the \u201cAuto select memories and ranges\u201d option on the \u201cMemories to Program\u201d property page, change to manual mode and adjust your range(s) accordingly.</td>
</tr>
<tr>
<td>PRESERVE_MEM_RANGE_WONT_BE_PROGRAMMED</td>
<td>Some or all of the preserve memory ranges (%) entered on the &quot;Memories to Program&quot; property page, do not fall under the indicated program range(s) (%) for the memory selected. Please check the preserved ranges on the debug tool's, &quot;Memories to Program&quot; property page.</td>
</tr>
<tr>
<td>PROGRAM_CFG_WARNING</td>
<td>WARNING: You have selected to program configuration memory. Programming invalid values into any of the configuration fields may have unintended consequences. Please make sure that EVERY configuration field has a valid value. If you are not sure, you can read the configuration values off of device first and then change only the fields you are concerned with. Would you like to continue programming?</td>
</tr>
<tr>
<td>PROGRAM_COMPLETE</td>
<td>Programming/Verify complete</td>
</tr>
<tr>
<td>PROGRAM_MEMORY</td>
<td>program memory</td>
</tr>
<tr>
<td>PROGRAM</td>
<td>program</td>
</tr>
<tr>
<td>PROGRAMMING_DID_NOT_COMPLETE</td>
<td>Programming did not complete.</td>
</tr>
<tr>
<td>READ_COMPLETE</td>
<td>Read complete</td>
</tr>
<tr>
<td>READ_DID_NOT_COMPLETE</td>
<td>Read did not complete.</td>
</tr>
<tr>
<td>RELEASEMCLR_FAILED</td>
<td>Release from reset failed.</td>
</tr>
<tr>
<td>REMOVING_SWBPS_COMPLETE</td>
<td>Removing software breakpoints complete</td>
</tr>
<tr>
<td>REMOVING_SWBPS</td>
<td>Removing software breakpoints...</td>
</tr>
<tr>
<td>RESET_FAILED</td>
<td>Failed to reset the device</td>
</tr>
<tr>
<td>RESETING</td>
<td>Resetting...</td>
</tr>
<tr>
<td>RISKY_CFG_RANGE_REMOVED</td>
<td>The configuration memory will not be included in the program operation because the, &quot;Exclude configuration memory from programming&quot; option is set. To change this, go to the Memories to Program property page and uncheck the setting. \nWARNING: Programming configuration values on this device can cause unintended consequences if all of the configuration values are not properly set. It is advised that you read the configuration values off of device first and then change only the fields you are concerned with.</td>
</tr>
<tr>
<td>RUN_INTERRUPT_THREAD_SYNCH_ERROR</td>
<td>An internal run error has occurred. It is advised that you restart your debug session. You may continue running but certain run time features may no longer work properly.</td>
</tr>
<tr>
<td>RUN_TARGET_FAILED</td>
<td>Unable to run the target device.</td>
</tr>
<tr>
<td>RUNNING</td>
<td>Running</td>
</tr>
</tbody>
</table>
| SERIAL_NUM | Serial Number:
 |
| SETTING_SWBPS | Setting software breakpoints....... |
| STACK | stack |
| START_AND_END_ADDR | start address = 0x%x, end address = 0x%x |
| START | start |
| TARGET_DETECTED | Target voltage detected |
| TARGET_FOUND | Target device %s found. |
| TARGET_HALTED | Target Halted |
| TARGET_NOT_READY_4_DEBUG | The target device is not ready for debugging. Please check your configuration bit settings and program the device before proceeding. The most common causes for this failure are oscillator and/or PGC/PGD settings. |
| TARGET_VDD | Target VDD: |
| TEST | test |
| TOOL_INFO_MEMBERS | ToolInfo: speedLevel = %d, PGCResistance = %d, PGDResistance = %d, PGCPullDir = %s, PGDPullDir = %s, ICSPSelected = %s |
| TOOL_INFO | ToolInfo: Values: |
| TOOL_IS_BUSY | PICKit 4 is busy. Please wait for the current operation to finish. |
| TOOL_SUPPLYING_POWER | PICKit 4 is supplying power to the target (%.2f volts). |
| TOOL_VDD | VDD: |
### Error Messages

**TABLE 6-1: ALPHABETIZED LIST OF ERROR MESSAGES (CONTINUED)**

<table>
<thead>
<tr>
<th>Message Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>TOOL_VPP</strong></td>
<td>VPP:</td>
</tr>
<tr>
<td><strong>UNABLE_TO_OBTAIN_RESET_VECTOR</strong></td>
<td>PICKit 4 was unable to retrieve the reset vector address. This indicates that no _reset symbol has been defined and may prevent the device from starting up properly.</td>
</tr>
<tr>
<td><strong>UNKNOWN_MEMTYPE</strong></td>
<td>Unknown memory type</td>
</tr>
<tr>
<td><strong>UNLOAD_WHILE_BUSY</strong></td>
<td>PICKit 4 was unloaded while still busy. Please unplug and reconnect the USB cable before using PICKit 4 again.</td>
</tr>
<tr>
<td><strong>UPDATING_APP</strong></td>
<td>Updating firmware application...</td>
</tr>
<tr>
<td><strong>UPDATING_BOOTLOADER</strong></td>
<td>Updating firmware bootloader...</td>
</tr>
<tr>
<td><strong>USE_LVP_PROGRAMMING</strong></td>
<td>NOTE: If you would like to program this device using low voltage programming, select Cancel on this dialog. Then go to the PICKit 4 node of the project properties and check the Enable Low Voltage Programming check box of the Program Options Option Category pane (low voltage programming is not valid for debugging operations).</td>
</tr>
<tr>
<td><strong>USERID_MEMORY</strong></td>
<td>User Id Memory</td>
</tr>
<tr>
<td><strong>USERID</strong></td>
<td>User Id</td>
</tr>
<tr>
<td><strong>VERIFY_COMPLETE</strong></td>
<td>Verification successful.</td>
</tr>
<tr>
<td><strong>VERIFY_FAILED</strong></td>
<td>Verify failed</td>
</tr>
<tr>
<td><strong>VERSIONS</strong></td>
<td>Versions</td>
</tr>
<tr>
<td><strong>VOLTAGE_LEVEL_BAD_VALUE_EX</strong></td>
<td>You have entered an invalid value %s for the Voltage Level on the PICkit 4 Power property page. Please fix this before continuing.</td>
</tr>
<tr>
<td><strong>VOLTAGE_LEVEL_BAD_VALUE</strong></td>
<td>Unable to parse the voltage level %s. Please enter a valid voltage entry.</td>
</tr>
<tr>
<td><strong>VOLTAGE_LEVEL_OUT_OF_RANGE</strong></td>
<td>The target voltage level you have entered, %.3f, is outside the range of the device %.3f - %.3f.</td>
</tr>
<tr>
<td><strong>VOLTAGES</strong></td>
<td>Voltages</td>
</tr>
<tr>
<td><strong>WOULD_YOU_LIKE_TO_CONTINUE</strong></td>
<td>Would you like to continue?</td>
</tr>
<tr>
<td><strong>WRONG_PICKit_4_FLAVOR</strong></td>
<td>Your PICKit 4 hardware needs updating please contact PICKit <a href="mailto:4_Update@microchip.com">4_Update@microchip.com</a> to get a replacement.</td>
</tr>
</tbody>
</table>
6.3 GENERAL CORRECTIVE ACTIONS

These general corrective actions may solve your problem:

- Read/Write Error Actions
- Debugger-to-Target Communication Error Actions
- Debugger-to-computer Communication Error Actions
- Corrupted Installation Actions
- USB Port Communication Error Actions
- Debug Failure Actions
- Internal Error Actions

6.3.1 Read/Write Error Actions

If you receive a read or write error:

1. Did you hit Debug>Reset? This may produce read/write errors.
2. Try the action again. It may be a one-time error.
3. Ensure that the target is powered and at the correct voltage levels for the device. See the device data sheet for required device voltage levels.
4. Ensure that the debugger-to-target connection is correct (PGC and PGD are connected.)
5. For write failures, ensure that “Erase all before Program” is checked on the Program Options for the debugger (see Section A.3.2 “Debug”).
6. Ensure that the cable(s) are of the correct length.

6.3.2 Debugger-to-Target Communication Error Actions

The MPLAB PICkit 4 In-Circuit Debugger and the target device are out-of-sync with each other.

1. Select Debug>Reset and then try the action again.
2. Ensure that the cable(s) used are the correct length.

6.3.3 Debugger-to-computer Communication Error Actions

The MPLAB PICkit 4 In-Circuit Debugger and MPLAB X IDE are out-of-sync with each other.

1. Unplug and then plug in the debugger.
2. Reconnect to the debugger.
3. Try the operation again. It is possible the error was a one time event.
4. The version of MPLAB X IDE installed may be incorrect for the version of firmware loaded on the MPLAB PICkit 4 In-Circuit Debugger. Follow the steps outlined in Section 6.3.4 “Corrupted Installation Actions”.

6.3.4 Corrupted Installation Actions

The problem is most likely caused by a incomplete or corrupted installation of MPLAB X IDE.

1. Uninstall all versions of MPLAB X IDE from the computer.
2. Reinstall the desired MPLAB X IDE version.
3. If the problem persists contact Microchip.
6.3.5 USB Port Communication Error Actions

The problem is most likely caused by a faulty or non-existent communications port.
1. Reconnect to the MPLAB PICkit 4 In-Circuit Debugger
2. Make sure the appropriate USB port has been selected in the debugger options (see Section A.3 “Debugger Options Selection”).
3. Make sure the appropriate USB port has been selected in the debugger Settings.
4. Make sure the USB port is not in use by another device.
5. If using a USB hub, make sure it is powered.
6. Make sure the USB drivers are loaded.

6.3.6 Debug Failure Actions

The MPLAB PICkit 4 In-Circuit Debugger was unable to perform a debugging operation. There are numerous reasons why this might occur (see Section 4.3 “Top Reasons Why You Can’t Debug” and Section 4.4 “Other Things to Consider”).

6.3.7 Internal Error Actions

Internal errors are unexpected and should not happen. They are primarily used for internal Microchip development.

The most likely cause is a corrupted installation (Section 6.3.4 “Corrupted Installation Actions”).

Another likely cause is exhausted system resources.
1. Try rebooting your system to free up memory.
2. Make sure you have a reasonable amount of free space on your hard drive (and that it is not overly fragmented).

If the problem persists contact Microchip.
Part 3 – Reference

Appendix A. Debugger Function Summary ............................................................... 55
Appendix B. Hardware Specification ....................................................................... 61
Appendix C. Revision History .................................................................................. 67
Appendix A. Debugger Function Summary

A.1 INTRODUCTION

A summary of the MPLAB PICkit 4 in-circuit debugger functions is listed here.

- Debugger Selection and Switching
- Debugger Options Selection

A.2 DEBUGGER SELECTION AND SWITCHING

Use the Project Properties dialog to select or switch debuggers for a project. To switch you must have more than one debugger connected to your computer. MPLAB X IDE will differentiate between the two by displaying two different serial numbers.

To select or change the debugger used for a project:

1. Open the Project Properties dialog by doing one of the following:
   - Click on the project name in the Projects window and select File>Project Properties.
   - Right click on the project name in the Projects window and select “Properties”.
2. Under “Categories” on the left side, expand “Conf:[default]” to show PICkit 4.
3. Under “Hardware Tool”, find “PICkit 4” and click on a serial number (SN) to select a debugger for use in the project, then click Apply.

A.3 DEBUGGER OPTIONS SELECTION

Debugger options are set in the Project Properties dialog. Click on PICkit 4 under “Categories” to display the “Options for PICkit 4” (see Figure A-1). Use the “Options categories” drop list to select various options. Click on an option name to see its description in the Option Description box below. Click to the right of an option name to select or change it.

**Note:** The available option categories and the options within those categories are dependent on the device you have selected.
After setting the options, click **Apply** or **OK**. Also click the Refresh Debug Tool status icon in the MPLAB X IDE dashboard display to update any changes made.

The possible option categories are:

- **Memories to Program**
- **Debug**
- **Program**
- **Freeze Peripherals**
- **Power**
- **Programmer To Go** (coming soon)
- **Secure Segment**
- **Firmware**
- **Clock**
- **Communication**

### A.3.1 Memories to Program

Select the memories to be programmed into the target.

**TABLE A-1: MEMORIES TO PROGRAM OPTION CATEGORY**

<table>
<thead>
<tr>
<th>Option Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto select memories and ranges</td>
<td><em>Allow PICkit 4 to Select Memories</em> - The debugger uses your selected device and default settings to determine what to program. <em>Manually select memories and ranges</em> - You select the type and range of memory to program (see below.)</td>
</tr>
<tr>
<td>Configuration Memory</td>
<td>Check to program configuration memory.</td>
</tr>
<tr>
<td>Boot Flash (always programmed in debug mode)</td>
<td>Include configuration memory in the area(s) to be programmed.</td>
</tr>
<tr>
<td>ID</td>
<td>Check to program the User ID.</td>
</tr>
<tr>
<td>Program Memory</td>
<td>Check to program the target program memory range specified below.</td>
</tr>
</tbody>
</table>
### Table A-1: Memories to Program Option Category (Continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program Memory Range(s) (hex)</td>
<td>The range(s) of program memory to be programmed. Each range must be two hex numbers, representing the start and end addresses of the range, separated by a dash. Ranges must be separated by a comma (e.g. 0-ff, 200-2ff). Ranges must be aligned on an 0x800 address boundary. Note: The address range does not apply to the Erase function. The Erase function will erase all data on the device.</td>
</tr>
<tr>
<td>Preserve Program Memory</td>
<td>Enabling this option will cause the current program memory on the device to be read into MPLAB X IDE's memory and then reprogrammed back to the target device when programming is done. The range(s) of program memory that will be preserved is determined by the Preserve Program Memory Range(s) option below.</td>
</tr>
<tr>
<td>Preserve Program Memory Range(s) (hex)</td>
<td>The range(s) of program memory to be preserved. Each range must be two hex numbers, representing the start and end addresses of the range, separated by a dash. Ranges must be separated by a comma (e.g. 0-ff, 200-2ff). Areas are reserved by reading them into MPLAB X IDE and then programming them back down when a program operation occurs. Thus the preserved areas must lie within a memory range that will be programmed.</td>
</tr>
<tr>
<td>Preserve ID Memory</td>
<td>Check to not erase Memory when programming, where Memory is the type of memory. Types include: EEPROM, ID, Boot Flash, Auxiliary.</td>
</tr>
</tbody>
</table>

### A.3.2 Debug

If this option is available for the project device, you can select to use software breakpoints.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Software Breakpoints</td>
<td>Check to use software breakpoints. Uncheck to use hardware breakpoints. See discussion below to determine which type is best for your application.</td>
</tr>
</tbody>
</table>

### A.3.3 Program

Choose to erase all memory before programming or to merge code.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Erase All Before Program</td>
<td>Enabling this option will cause the entire device to be erased prior to programming the data from MPLAB X IDE. Any memory areas designated to be preserved will be read before the device is erased and reprogrammed on the device when the device is programmed. Unless programming new or already erased devices, it is important to have this box checked. If not checked, the device is not erased and program code will be merged with the code already in the device.</td>
</tr>
<tr>
<td>Programming mode entry</td>
<td>This option designates the method the PICkit 4 will use to put the target device in programming mode. For the low voltage method, VPP will not exceed the VDD supply voltage. Instead a test pattern will be used on VPP. For the high-voltage method, a voltage in excess of 9 volts will be place on VPP.</td>
</tr>
<tr>
<td>LED Brightness Setting</td>
<td>Select the level of brightness from 1 (darkest) to 10 (brightest).</td>
</tr>
</tbody>
</table>
A.3.4 Freeze Peripherals

Select from the list of peripherals to freeze or not freeze on program halt. The available peripherals are device dependent.

PIC12/16/18 MCU Devices

To freeze/unfreeze all device peripherals on halt, check/uncheck the "Freeze on Halt" check box. If this does not halt your desired peripheral, be aware that some peripherals have no freeze on halt capability and cannot be controlled by the debugger.

dsPIC, PIC24 and PIC32 Devices

Select the peripheral’s check box in the “Peripherals to Freeze on Halt” list, to freeze it on a halt. Uncheck the peripheral to let it run while the program is halted. If you do not see a peripheral on the list, check “All Other Peripherals.” If this does not halt your desired peripheral, be aware that some peripherals have no freeze on halt capability and cannot be controlled by the debugger.

To select all peripherals, including “All Other Peripherals,” click Check All. To deselect all peripherals, including “All Other Peripherals,” click Uncheck All.

A.3.5 Power

Select power options.

TABLE A-4: POWER OPTION CATEGORY

<table>
<thead>
<tr>
<th>Power target circuit from PICkit 4</th>
<th>If checked, this option will allow the PICkit 4 to power the target circuit. Otherwise an external power supply must be used (see Section 2.3.4 “Debugger Powered”).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage Level</td>
<td>If the “Power Target Circuit from PICkit 4” check box is checked, select the target VDD (1.2V-5.5V) that the debugger will provide.</td>
</tr>
</tbody>
</table>

A.3.6 Programmer To Go

If the Programmer To Go option is to be used in the “Image Name” field, type the name of the file that will be used for programming.

1. This functionality is coming soon with a firmware update of the product through MPLAB X IDE.
A.3.7 Secure Segment
Select and load debugger firmware.

**TABLE A-5: SECURE SEGMENT OPTION CATEGORY**

| Segments to be Programmed | Select one of the following: Full Chip Programming (default); Boot, Secure and General Segments; Secure and General Segments; or General Segment Only. |

A.3.8 Firmware
Select and load debugger firmware. MPLAB X IDE automatically downloads the correct firmware for your project. Only change this setting if you are having issues.

**TABLE A-6: FIRMWARE OPTION CATEGORY**

| Use Latest Firmware | Check to use the latest firmware. Uncheck to select the firmware version. |
| Firmware File | Click in the right-hand text box to search for a firmware file (.jam) to associate with the debugger. |

A.3.9 Clock
Set the option to use the fast internal RC clock for the selected device.

**TABLE A-7: CLOCK OPTION CATEGORY**

| Use FRC in Debug mode (dsPIC33F and PIC24F/H devices only) | When debugging, use the device fast internal RC (FRC) for clocking instead of the oscillator specified for the application. This is useful when the application clock is slow. Checking this check box will let the application run at the slow speed but debug at the faster FRC speed. Reprogram after changing this setting. **Note:** Peripherals that are not frozen will operate at the FRC speed while debugging. |

A.3.10 Communication
Set the option(s) to use for your device and type of target communication.

**TABLE A-8: COMMUNICATION OPTION CATEGORY**

| Interface | Select the interface from the available options. |
| Speed (MHz) | Enter a speed based on the available range for the interface. |
Appendix B. Hardware Specification

B.1 INTRODUCTION

The hardware and electrical specifications of the MPLAB PICkit 4 In-Circuit Debugger system are detailed. These topics are covered:

- USB Connector
- MPLAB PICkit™ 4 In-Circuit Debugger
- Standard Communication Hardware
- Target Board Considerations

B.2 USB CONNECTOR

The MPLAB PICkit 4 In-Circuit Debugger is connected to the host computer via a Micro-B USB connector, version 2.0 compliant. The Micro-B USB connector is located on the top of the debugger.

The system is capable of reloading the firmware via the USB interface.

System power is derived from the USB interface. The debugger is classified as a high power system per the USB specification, and requires slightly more than 50 mA of power from the USB to function in all operational modes (debugger/programmer).

**Note:** The MPLAB PICkit 4 In-Circuit Debugger is powered through its Micro-B USB connector. The target board is powered from its own supply. Alternatively, the MPLAB PICkit 4 can power the target board only if the target consumes less than 50 mA.

**Cable Length** – The computer-to-debugger cable, shipped with the debugger kit, is the correct length for proper operation.

**Powered Hubs** – If you are going to use a USB hub, make sure it is self-powered. Also, USB ports on computer keyboards do not have enough power for the debugger to operate.

**Computer Hibernate/Power-Down Modes** – Disable the hibernate or other power saver modes on your computer to ensure proper USB communications with the debugger.
B.3 MPLAB PICkit™ 4 IN-CIRCUIT DEBUGGER

The debugger consists of an internal main board and an external Micro-B USB connector and an 8-pin SIL connector. On the face of the debugger enclosure is an indicator light strip and a push button located under the logo.

FIGURE B-1: MPLAB PICkit™ 4 IN-CIRCUIT DEBUGGER

1. Lanyard Connection - An opening through the top and side for a lanyard (not included) to be attached.
2. Emergency Recovery Button - If needed, this recessed button is used for Recovery Boot Mode.
3. Micro-B USB Connector - Used to connect the MPLAB PICkit 4 to the computer with the supplied USB cable.
4. Indicator Light Strip - Displays the operational modes of the MPLAB PICkit 4 in-circuit debugger (see Section B.3.2 “Indicator Light Strip”).
5. Button Area - The area in the center of the shield logo is used for the Programmer-To-Go1 option and for invoking the bootloader mode (see Section 4.4.2 “How to Invoke the Bootloader Mode”).
6. Pin 1 Marker - This designates the pin 1 location for proper connector alignment.
7. Programming Connector - The connector is an 8-pin SIL header (0.100" spacing) that connects to the target device. See Table B-5 for the pinout specifications.
8. Micro SD Card Slot\(^1\) - The micro SD card slot supports a large variety of microSD cards with various speed requirements.

**B.3.1 Main Board**

The main board includes the following features:

- A 32-bit microcontroller using an ARM® Cortex®-M7 core
- A USB 2.0 interface capable of USB speeds of 480 Mbps
- An SRAM for holding the program code image. This image is used for programming on-board Flash device.
- One LED

**B.3.2 Indicator Light Strip**

The expected start-up sequence for the MPLAB PICkit 4 debugger is:

1. Purple - steady on for approximately 4 seconds
2. Blue - steady on. The debugger is ready.

The indicator light strip has the following significance.

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue</td>
<td>Power is connected; debugger in standby.</td>
</tr>
<tr>
<td>Orange</td>
<td>Power target circuit from PICkit 4 checked</td>
</tr>
<tr>
<td>Green</td>
<td>Power target circuit from PICkit 4 unchecked</td>
</tr>
<tr>
<td>Red</td>
<td>Lit when the debugger has failed.</td>
</tr>
</tbody>
</table>

The following tables provide descriptions of the indicator lights and bootloader errors.

<table>
<thead>
<tr>
<th>Light Strip</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal Modes</td>
<td>Power is connected; debugger in standby.</td>
</tr>
<tr>
<td>Blue</td>
<td>Power target circuit from PICkit 4 checked (Table A-4)</td>
</tr>
<tr>
<td>Orange</td>
<td>Power target circuit from PICkit 4 unchecked (Table A-4)</td>
</tr>
<tr>
<td>Purple</td>
<td>Bootloader is running</td>
</tr>
<tr>
<td>Yellow</td>
<td>Debugger is busy</td>
</tr>
<tr>
<td>Red</td>
<td>An operation has failed</td>
</tr>
<tr>
<td>Purple</td>
<td>Fast blink indicates the time window for forcing the debugger into Bootloader mode</td>
</tr>
</tbody>
</table>

---

\(^1\)This functionality is coming soon with a firmware update of the product through MPLAB X IDE.
TABLE B-3: BOOTLOADER ERROR DESCRIPTIONS

<table>
<thead>
<tr>
<th>Bootloader Errors</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red, slow blink</td>
<td>Problem accessing the debugger’s serial EEPROM</td>
</tr>
<tr>
<td>Red, fast blink</td>
<td>Bootloader API commands cannot be processed</td>
</tr>
<tr>
<td>White, fast blink</td>
<td>A runtime exception occurred in the tool firmware</td>
</tr>
</tbody>
</table>

B.4 STANDARD COMMUNICATION HARDWARE

For standard debugger communication with a target (see Section 2.2 “Debugger to Target Communication” and “Standard ICSP™ Device Communication”), either directly connect the MPLAB PICkit 4 debugger directly to the target or use a header if needed. The debugger has an 8-pin SIL connector. If the target has a 6-pin connector, make sure to align the Pin 1 appropriately.

B.4.1 Standard Communication

The main interface to the target processor is via standard communication. It contains the connections to the high voltage (VPP), VDD sense lines, and clock and data connections that are required for programming and connecting with the target devices.

The VPP high-voltage lines can produce a variable voltage that can swing from 0-14V to satisfy the voltage requirements of the specific emulation processor.

The VDD sense connection draws current from the target processor. The actual power comes from the MPLAB PICkit 4 In-Circuit Debugger system, as the Vdd sense line is used as a reference only to track the target voltage.

The clock and data connections are interfaces with the following characteristics:

- Clock and data signals are in high-impedance mode (even when no power is applied to the MPLAB PICkit 4 In-Circuit Debugger system).
- Clock and data signals are protected from high voltages caused by faulty targets systems, or improper connections.
- Clock and data signals are protected from high current caused from electrical shorts in prototype or target systems.

TABLE B-4: ELECTRICAL LOGIC TABLE

<table>
<thead>
<tr>
<th>Logic Inputs</th>
<th>$V_{IH} = VDD \times 0.7V$ (min.)</th>
<th>$V_{IL} = VDD \times 0.3V$ (max.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logic Outputs</td>
<td>$V_{DD} = 5V$</td>
<td>$V_{DD} = 3V$</td>
</tr>
<tr>
<td></td>
<td>$V_{OH} = 3.8V$ min.</td>
<td>$V_{OH} = 2.4V$ min.</td>
</tr>
<tr>
<td></td>
<td>$V_{OL} = 0.55V$ max.</td>
<td>$V_{OL} = 0.55V$ max.</td>
</tr>
</tbody>
</table>
B.4.2 Pinouts for Interfaces

The programming connector pin functions are different for various devices and interfaces. Refer to the following pinout tables for debug and data stream interfaces.

Note: Refer to the data sheet for the device you are using as well as the application notes for the specific interface for additional information and diagrams.

### TABLE B-5: PINOUTS FOR DEBUG INTERFACES

<table>
<thead>
<tr>
<th>MPLAB PICkit 4</th>
<th>ICSP</th>
<th>MIPS</th>
<th>CORTEX</th>
<th>AVR</th>
<th>AVR ISP</th>
<th>UPDI</th>
<th>PDI</th>
<th>aW</th>
<th>dW</th>
<th>TPI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pin #</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>VPP</td>
<td>NMCLR</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>VDD</td>
<td>VIO_REF</td>
<td>VTG</td>
<td>VTG</td>
<td>VTG</td>
<td>VTG</td>
<td>VTG</td>
<td>VTG</td>
<td>VTG</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>GND</td>
<td>GND</td>
<td>GND</td>
<td>GND</td>
<td>GND</td>
<td>GND</td>
<td>GND</td>
<td>GND</td>
<td>GND</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>PGD</td>
<td>TDO</td>
<td>SWo</td>
<td>TDO</td>
<td>MISO</td>
<td>UPDI</td>
<td>PDI</td>
<td>aW</td>
<td>dW</td>
<td>TPI</td>
</tr>
<tr>
<td>5</td>
<td>PGC</td>
<td>TCK</td>
<td>SWCLK</td>
<td>TCK</td>
<td>SCK</td>
<td>PDI_DAT</td>
<td>DATA</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>AUX</td>
<td>NRESET</td>
<td>NRST</td>
<td>RESET</td>
<td>RESET*</td>
<td>PDI_CLK</td>
<td>dW</td>
<td></td>
<td></td>
<td>RST</td>
</tr>
<tr>
<td>7</td>
<td>TDI</td>
<td>TDI</td>
<td>NRST</td>
<td>TDI</td>
<td>MOSI</td>
<td>UART</td>
<td>USART</td>
<td>UART</td>
<td>BB</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>TMS</td>
<td>TMS</td>
<td>SWDIO</td>
<td>TMS</td>
<td></td>
<td>UART</td>
<td>BB</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Module: BB BB BB SPI UART USART UART BB
TABLE B-6: PINOUTS FOR DATA STREAM INTERFACES

<table>
<thead>
<tr>
<th>Pin #</th>
<th>DMCI / DGI U(S)ART / CDC</th>
<th>DGI SPI</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>VTG</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>GND</td>
<td>MISO</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>SCK</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>(SCK)</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>TX</td>
<td>MOSI</td>
</tr>
<tr>
<td>8</td>
<td>RX</td>
<td>SS</td>
</tr>
</tbody>
</table>

B.5 TARGET BOARD CONSIDERATIONS

The target board should be powered according to the requirements of the selected device and the application.

**Note:** Stresses above those listed under “Absolute Maximum Ratings” in the device’s data sheet may cause permanent damage to the device. This is a stress rating only and functional operation of the device at those or any other conditions, above those indicated in the operation listings of this specification, is not implied. Exposure to maximum rating conditions for extended periods may affect device reliability.

The debugger does sense target voltage. There is a 182K ohm load on VDD_TGT. Depending on the type of debugger-to-target communication that is used, there are some considerations for target board circuitry:

- **Section 2.3.2 “Target Connection Circuitry”**
- **Section 2.3.5 “Circuits That Will Prevent the Debugger From Functioning”**
Appendix C. Revision History

Revision A (May 2018)
This is the initial release of this document.

Revision B (August 2018)
- Added information on the Debug Adapter Board in Section 1.4 “MPLAB PICkit 4 In-Circuit Debugger Components”.
- Expanded Table B-5 to include pinouts for additional interfaces.
- Added a note to refer to device data sheets and application notes for debug interfaces in Section B.4.2 “Pinouts for Interfaces” and Section 2.3 “Target Communication Connections”.
INTRODUCTION

Please refer to the items discussed here for support issues.

- Warranty Registration
- The Microchip Web Site
- myMicrochip Personalized Notification Service
- Customer Support

WARRANTY REGISTRATION

If your development tool package includes a Warranty Registration Card, please complete the card and mail it in promptly. Sending in your Warranty Registration Card entitles you to receive new product updates. Interim software releases are available at the Microchip web site.

THE MICROCHIP WEB SITE

Microchip provides online support via our web site (http://www.microchip.com/). This web site is used as a means to make files and information easily available to customers. Accessible by using your favorite Internet browser, the web site contains the following information:

- **Product Support** – Data sheets and errata, application notes and sample programs, design resources, user’s guides and hardware support documents, latest software releases and archived software
- **General Technical Support** – Frequently Asked Questions (FAQs), technical support requests, online discussion groups, Microchip consultant program member listing
- **Business of Microchip** – Product selector and ordering guides, latest Microchip press releases, listing of seminars and events, listings of Microchip sales offices, distributors and factory representatives

myMICROCHIP PERSONALIZED NOTIFICATION SERVICE

Microchip’s personal notification service helps keep customers current on their Microchip products of interest. Subscribers will receive e-mail notification whenever there are changes, updates, revisions or errata related to a specified product family or development tool.

To begin the registration process and select your preferences to receive personalized notifications, go to:

http://www.microchip.com/pcn

A FAQ and registration details are available on the page, which can be opened by selecting the link above.
When you are selecting your preferences, choosing “Development Systems” will populate the list with available development tools. The main categories of tools are listed below:

- **Compilers** – The latest information on Microchip C compilers, assemblers, linkers and other language tools. These include all MPLAB C compilers; all MPLAB® assemblers (including MPASM™ assembler); all MPLAB linkers (including MPLINK™ object linker); and all MPLAB librarians (including MPLIB™ object librarian).
- **Emulators** – The latest information on the MPLAB REAL ICE™ emulator.
- **In-Circuit Debuggers** – The latest information on Microchip in-circuit debuggers. These include the MPLAB ICD 3 and MPLAB ICD 4 in-circuit debuggers and PICkit™ 3 and MPLAB PICkit 4 in-circuit debuggers.
- **MPLAB® X IDE** – The latest information on Microchip MPLAB X IDE, the multi-platform (Windows®, macOS™, Linux®) Integrated Development Environment for development systems tools.
- **Programmers** – The latest information on Microchip programmers. These include the device (production) programmers MPLAB REAL ICE in-circuit emulator, MPLAB ICD 4 in-circuit debugger, MPLAB PICkit 4 in-circuit debugger, MPLAB PM3 and development (non-production) programmer and PICkit 3.
- **Starter/Demo Boards** – These include MPLAB Starter Kit boards, PICDEM demo boards, and various other evaluation boards.

**CUSTOMER SUPPORT**

Users of Microchip products can receive assistance through several channels:

- Distributor or Representative
- Local Sales Office
- Field Application Engineer (FAE)
- Technical Support

Customers should contact their distributor, representative or field application engineer (FAE) for support. Local sales offices are also available to help customers. A listing of sales offices and locations is included in the back of this document. See our web site for a complete, up-to-date listing of sales offices.

Technical support is available through the support web site:
http://support.microchip.com

Documentation errors or comments may be emailed to docerrors@microchip.com.
Glossary

A

Absolute Section
A GCC compiler section with a fixed (absolute) address that cannot be changed by the linker.

Absolute Variable/Function
A variable or function placed at an absolute address using the OCG compiler’s @address syntax.

Access Memory
PIC18 Only – Special registers on PIC18 devices that allow access regardless of the setting of the Bank Select Register (BSR).

Access Entry Points
Access entry points provide a way to transfer control across segments to a function which may not be defined at link time. They support the separate linking of boot and secure application segments.

Address
Value that identifies a location in memory.

Alphabetic Character
Alphabetic characters are those characters that are letters of the Roman alphabet (a, b, ..., z, A, B, ..., Z).

Alphanumeric
Alphanumeric characters are comprised of alphabetic characters and decimal digits (0,1, ..., 9).

ANDed Breakpoints
Set up an ANDed condition for breaking, i.e., breakpoint 1 AND breakpoint 2 must occur at the same time before a program halt. This can only be accomplished if a data breakpoint and a program memory breakpoint occur at the same time.

Anonymous Structure
16-bit C Compiler – An unnamed structure.

PIC18 C Compiler – An unnamed structure that is a member of a C union. The members of an anonymous structure may be accessed as if they were members of the enclosing union. For example, in the following code, hi and lo are members of an anonymous structure inside the union caster.

```c
union castaway
    int intval;
    struct {
        char lo; //accessible as caster.lo
        char hi; //accessible as caster.hi
    };
} caster;
```
ANSI
American National Standards Institute is an organization responsible for formulating and approving standards in the United States.

Application
A set of software and hardware that may be controlled by a PIC® microcontroller.

Archive/Archiver
An archive/library is a collection of relocatable object modules. It is created by assembling multiple source files to object files, and then using the archiver/librarian to combine the object files into one archive/library file. An archive/library can be linked with object modules and other archives/libraries to create executable code.

ASCII
American Standard Code for Information Interchange is a character set encoding that uses 7 binary digits to represent each character. It includes upper and lower case letters, digits, symbols and control characters.

Assembly/Assembler
Assembly is a programming language that describes binary machine code in a symbolic form. An assembler is a language tool that translates assembly language source code into machine code.

Assigned Section
A GCC compiler section which has been assigned to a target memory block in the linker command file.

Asynchronously
Multiple events that do not occur at the same time. This is generally used to refer to interrupts that may occur at any time during processor execution.

Asynchronous Stimulus
Data generated to simulate external inputs to a simulator device.

Attribute
GCC Characteristics of variables or functions in a C program which are used to describe machine-specific properties.

Attribute, Section
GCC Characteristics of sections, such as “executable”, “readonly”, or “data” that can be specified as flags in the assembler .section directive.

B

Binary
The base two numbering system that uses the digits 0-1. The rightmost digit counts ones, the next counts multiples of 2, then $2^2 = 4$, etc.

Bookmarks
Use bookmarks to easily locate specific lines in a file.

Select Toggle Bookmarks on the Editor toolbar to add/remove bookmarks. Click other icons on this toolbar to move to the next or previous bookmark.

Breakpoint
Hardware Breakpoint: An event whose execution will cause a halt.

Software Breakpoint: An address where execution of the firmware will halt. Usually achieved by a special break instruction.
Build
Compile and link all the source files for an application.

C

C/C++
C is a general-purpose programming language which features economy of expression, modern control flow and data structures, and a rich set of operators. C++ is the object-oriented version of C.

Calibration Memory
A special function register or registers used to hold values for calibration of a PIC microcontroller on-board RC oscillator or other device peripherals.

Central Processing Unit
The part of a device that is responsible for fetching the correct instruction for execution, decoding that instruction, and then executing that instruction. When necessary, it works in conjunction with the arithmetic logic unit (ALU) to complete the execution of the instruction. It controls the program memory address bus, the data memory address bus, and accesses to the stack.

Clean
Clean removes all intermediary project files, such as object, hex and debug files, for the active project. These files are recreated from other files when a project is built.

COFF
Common Object File Format. An object file of this format contains machine code, debugging and other information.

Command Line Interface
A means of communication between a program and its user based solely on textual input and output.

Compiled Stack
A region of memory managed by the compiler in which variables are statically allocated space. It replaces a software or hardware stack when such mechanisms cannot be efficiently implemented on the target device.

Compiler
A program that translates a source file written in a high-level language into machine code.

Conditional Assembly
Assembly language code that is included or omitted based on the assembly-time value of a specified expression.

Conditional Compilation
The act of compiling a program fragment only if a certain constant expression, specified by a preprocessor directive, is true.

Configuration Bits
Special-purpose bits programmed to set PIC MCU and dsPIC DSC modes of operation. A Configuration bit may or may not be preprogrammed.

Control Directives
Directives in assembly language code that cause code to be included or omitted based on the assembly-time value of a specified expression.

CPU
See Central Processing Unit.
Cross Reference File
A file that references a table of symbols and a list of files that references the symbol. If the symbol is defined, the first file listed is the location of the definition. The remaining files contain references to the symbol.

D
Data Directives
Data directives are those that control the assembler’s allocation of program or data memory and provide a way to refer to data items symbolically; that is, by meaningful names.

Data Memory
On Microchip MCU and DSC devices, data memory (RAM) is comprised of General Purpose Registers (GPRs) and Special Function Registers (SFRs). Some devices also have EEPROM data memory.

Data Monitor and Control Interface (DMCI)
The Data Monitor and Control Interface, or DMCI, is a tool in MPLAB X IDE. The interface provides dynamic input control of application variables in projects. Application-generated data can be viewed graphically using any of 4 dynamically-assignable graph windows.

Debug/Debugger
See ICE/ICD.

Debugging Information
Compiler and assembler options that, when selected, provide varying degrees of information used to debug application code. See compiler or assembler documentation for details on selecting debug options.

Deprecated Features
Features that are still supported for legacy reasons, but will eventually be phased out and no longer used.

Device Programmer
A tool used to program electrically programmable semiconductor devices such as microcontrollers.

Digital Signal Controller
A digital signal controller (DSC) is a microcontroller device with digital signal processing capability, i.e., Microchip dsPIC DSC devices.

Digital Signal Processing|Digital Signal Processor
Digital signal processing (DSP) is the computer manipulation of digital signals, commonly analog signals (sound or image) which have been converted to digital form (sampled). A digital signal processor is a microprocessor that is designed for use in digital signal processing.

Directives
Statements in source code that provide control of the language tool’s operation.

Download
Download is the process of sending data from a host to another device, such as an emulator, programmer or target board.

DWARF
Debug With Arbitrary Record Format. DWARF is a debug information format for ELF files.
E

EEPROM
Electrically Erasable Programmable Read Only Memory. A special type of PROM that can be erased electrically. Data is written or erased one byte at a time. EEPROM retains its contents even when power is turned off.

ELF
Executable and Linking Format. An object file of this format contains machine code. Debugging and other information is specified in with DWARF. ELF/DWARF provide better debugging of optimized code than COFF.

Emulation/Emulator
See ICE/ICD.

Endianness
The ordering of bytes in a multi-byte object.

Environment
MPLAB PM4 – A folder containing files on how to program a device. This folder can be transferred to a SD/MMC card.

Epilogue
A portion of compiler-generated code that is responsible for deallocating stack space, restoring registers and performing any other machine-specific requirement specified in the runtime model. This code executes after any user code for a given function, immediately prior to the function return.

EPROM
Erasable Programmable Read Only Memory. A programmable read-only memory that can be erased usually by exposure to ultraviolet radiation.

Error/Error File
An error reports a problem that makes it impossible to continue processing your program. When possible, an error identifies the source file name and line number where the problem is apparent. An error file contains error messages and diagnostics generated by a language tool.

Event
A description of a bus cycle which may include address, data, pass count, external input, cycle type (fetch, R/W), and time stamp. Events are used to describe triggers, breakpoints and interrupts.

Executable Code
Software that is ready to be loaded for execution.

Export
Send data out of the MPLAB IDE/MPLAB X IDE in a standardized format.

Expressions
Combinations of constants and/or symbols separated by arithmetic or logical operators.

Extended Microcontroller Mode
In extended microcontroller mode, on-chip program memory as well as external memory is available. Execution automatically switches to external if the program memory address is greater than the internal memory space of the PIC18 device.
Extended Mode (PIC18 MCUs)
In Extended mode, the compiler will utilize the extended instructions (i.e., ADDFSR, ADDULNK, CALLW, MOVSF, MOVSS, PUSHL, SUBFSR and SUBULNK) and the indexed with literal offset addressing.

External Label
A label that has external linkage.

External Linkage
A function or variable has external linkage if it can be referenced from outside the module in which it is defined.

External Symbol
A symbol for an identifier which has external linkage. This may be a reference or a definition.

External Symbol Resolution
A process performed by the linker in which external symbol definitions from all input modules are collected in an attempt to resolve all external symbol references. Any external symbol references which do not have a corresponding definition cause a linker error to be reported.

External Input Line
An external input signal logic probe line (TRIGIN) for setting an event based upon external signals.

External RAM
Off-chip Read/Write memory.

F
Fatal Error
An error that will halt compilation immediately. No further messages will be produced.

File Registers
On-chip data memory, including General Purpose Registers (GPRs) and Special Function Registers (SFRs).

Filter
Determine by selection what data is included/excluded in a trace display or data file.

Fixup
The process of replacing object file symbolic references with absolute addresses after relocation by the linker.

Flash
A type of EEPROM where data is written or erased in blocks instead of bytes.

FNOP
Forced No Operation. A forced NOP cycle is the second cycle of a two-cycle instruction. Since the PIC microcontroller architecture is pipelined, it prefetches the next instruction in the physical address space while it is executing the current instruction. However, if the current instruction changes the program counter, this prefetched instruction is explicitly ignored, causing a forced NOP cycle.

Frame Pointer
A pointer that references the location on the stack that separates the stack-based arguments from the stack-based local variables. Provides a convenient base from which to access local variables and other values for the current function.
Free-Standing
An implementation that accepts any strictly conforming program that does not use complex types and in which the use of the features specified in the library clause (ANSI ‘89 standard clause 7) is confined to the contents of the standard headers `<float.h>`, `<iso646.h>`, `<limits.h>`, `<stdarg.h>`, `<stdbool.h>`, `<stddef.h>` and `<stdint.h>`.

G

GPR
General Purpose Register. The portion of device data memory (RAM) available for general use.

H

Halt
A stop of program execution. Executing Halt is the same as stopping at a breakpoint.

Heap
An area of memory used for dynamic memory allocation where blocks of memory are allocated and freed in an arbitrary order determined at runtime.

Hex Code/Hex File
Hex code is executable instructions stored in a hexadecimal format code. Hex code is contained in a hex file.

Hexadecimal
The base 16 numbering system that uses the digits 0-9 plus the letters A-F (or a-f). The digits A-F represent hexadecimal digits with values of (decimal) 10 to 15. The rightmost digit counts ones, the next counts multiples of 16, then $16^2 = 256$, etc.

High Level Language
A language for writing programs that is further removed from the processor than assembly.

I

ICE/ICD
In-Circuit Emulator/In-Circuit Debugger: A hardware tool that debugs and programs a target device. An emulator has more features than an debugger, such as trace.

In-Circuit Emulation/In-Circuit Debug: The act of emulating or debugging with an in-circuit emulator or debugger.

-ICE/-ICD: A device (MCU or DSC) with on-board in-circuit emulation or debug circuitry. This device is always mounted on a header board and used to debug with an in-circuit emulator or debugger.

ICSP™
In-Circuit Serial Programming. A method of programming Microchip embedded devices using serial communication and a minimum number of device pins.

IDE
Integrated Development Environment, as in MPLAB IDE/MPLAB X IDE.

Identifier
A function or variable name.

IEEE
Institute of Electrical and Electronics Engineers.
Import
Bring data into the MPLAB IDE/MPLAB X IDE from an outside source, such as from a hex file.

Initialized Data
Data which is defined with an initial value. In C,
```c
int myVar=5;
```
defines a variable which will reside in an initialized data section.

Instruction Set
The collection of machine language instructions that a particular processor understands.

Instructions
A sequence of bits that tells a central processing unit to perform a particular operation and can contain data to be used in the operation.

Internal Linkage
A function or variable has internal linkage if it can not be accessed from outside the module in which it is defined.

International Organization for Standardization
An organization that sets standards in many businesses and technologies, including computing and communications. Also known as ISO.

Interrupt
A signal to the CPU that suspends the execution of a running application and transfers control to an Interrupt Service Routine (ISR) so that the event may be processed. Upon completion of the ISR, normal execution of the application resumes.

Interrupt Handler
A routine that processes special code when an interrupt occurs.

Interrupt Service Request (IRQ)
An event which causes the processor to temporarily suspend normal instruction execution and to start executing an interrupt handler routine. Some processors have several interrupt request events allowing different priority interrupts.

Interrupt Service Routine (ISR)
Language tools – A function that handles an interrupt.
MPLAB IDE/MPLAB X IDE – User-generated code that is entered when an interrupt occurs. The location of the code in program memory will usually depend on the type of interrupt that has occurred.

Interrupt Vector
Address of an interrupt service routine or interrupt handler.

L

L-value
An expression that refers to an object that can be examined and/or modified. An l-value expression is used on the left-hand side of an assignment.

Latency
The time between an event and its response.

Library/Librarian
See Archive/Archiver.
Linker
A language tool that combines object files and libraries to create executable code, resolving references from one module to another.

Linker Script Files
Linker script files are the command files of a linker. They define linker options and describe available memory on the target platform.

Listing Directives
Listing directives are those directives that control the assembler listing file format. They allow the specification of titles, pagination and other listing control.

Listing File
A listing file is an ASCII text file that shows the machine code generated for each C source statement, assembly instruction, assembler directive, or macro encountered in a source file.

Little Endian
A data ordering scheme for multibyte data whereby the least significant byte is stored at the lower addresses.

Local Label
A local label is one that is defined inside a macro with the LOCAL directive. These labels are particular to a given instance of a macro's instantiation. In other words, the symbols and labels that are declared as local are no longer accessible after the ENDM macro is encountered.

Logic Probes
Up to 14 logic probes can be connected to some Microchip emulators. The logic probes provide external trace inputs, trigger output signal, +5V, and a common ground.

Loop-Back Test Board
Used to test the functionality of the MPLAB REAL ICE in-circuit emulator.

LVDS
Low Voltage Differential Signaling. A low noise, low-power, low amplitude method for high-speed (gigabits per second) data transmission over copper wire.

With standard I/O signaling, data storage is contingent upon the actual voltage level. Voltage level can be affected by wire length (longer wires increase resistance, which lowers voltage). But with LVDS, data storage is distinguished only by positive and negative voltage values, not the voltage level. Therefore, data can travel over greater lengths of wire while maintaining a clear and consistent data stream.

Source: http://www.webopedia.com/TERM/L/LVDS.html

M

Machine Code
The representation of a computer program that is actually read and interpreted by the processor. A program in binary machine code consists of a sequence of machine instructions (possibly interspersed with data). The collection of all possible instructions for a particular processor is known as its “instruction set.”

Machine Language
A set of instructions for a specific central processing unit, designed to be usable by a processor without being translated.
Macro
Macro instruction. An instruction that represents a sequence of instructions in abbreviated form.

Macro Directives
Directives that control the execution and data allocation within macro body definitions.

Makefile
Export to a file the instructions to Make the project. Use this file to Make your project outside of MPLAB IDE/MPLAB X IDE, i.e., with a make.

Make Project
A command that rebuilds an application, recompiling only those source files that have changed since the last complete compilation.

MCU
Microcontroller Unit. An abbreviation for microcontroller. Also uC.

Memory Model
For C compilers, a representation of the memory available to the application. For the PIC18 C compiler, a description that specifies the size of pointers that point to program memory.

Message
Text displayed to alert you to potential problems in language tool operation. A message will not stop operation.

Microcontroller
A highly integrated chip that contains a CPU, RAM, program memory, I/O ports and timers.

Microcontroller Mode
One of the possible program memory configurations of PIC18 microcontrollers. In microcontroller mode, only internal execution is allowed. Thus, only the on-chip program memory is available in microcontroller mode.

Microprocessor Mode
One of the possible program memory configurations of PIC18 microcontrollers. In microprocessor mode, the on-chip program memory is not used. The entire program memory is mapped externally.

Mnemonics
Text instructions that can be translated directly into machine code. Also referred to as opcodes.

Module
The preprocessed output of a source file after preprocessor directives have been executed. Also known as a translation unit.

MPASM™ Assembler
Microchip Technology’s relocatable macro assembler for PIC microcontroller devices, KeeLoq® devices and Microchip memory devices.

MPLAB Language Tool for Device
Microchip’s C compilers, assemblers and linkers for specified devices. Select the type of language tool based on the device you will be using for your application, e.g., if you will be creating C code on a PIC18 MCU, select the MPLAB C Compiler for PIC18 MCUs.
MPLAB ICD
Microchip in-circuit debugger that works with MPLAB IDE/MPLAB X IDE. See ICE/ICD.

MPLAB X IDE
Microchip’s Integrated Development Environment. MPLAB X IDE comes with an editor, project manager and simulator.

MPLAB PICkit™ 4 In-Circuit Debugger
Microchip’s next-generation in-circuit debugger that can program devices with or without the MPLAB X IDE. See the Readme files for each tool to see which devices are supported.

MPLAB PM4
A device programmer from Microchip. Programs PIC18 microcontrollers and dsPIC digital signal controllers. Can be used with MPLAB IDE/MPLAB X IDE or stand-alone. Replaces PRO MATE II.

MPLAB REAL ICE™ In-Circuit Emulator
Microchip’s next-generation in-circuit emulator that works with MPLAB IDE/MPLAB X IDE. See ICE/ICD.

MPLAB SIM
Microchip’s simulator that works with MPLAB IDE/MPLAB X IDE in support of PIC MCU and dsPIC DSC devices.

MPLAB Starter Kit for Device
Microchip’s starter kits contains everything needed to begin exploring the specified device. View a working application and then debug and program your own changes.

MPLIB™ Object Librarian
Microchip’s librarian that can work with MPLAB IDE/MPLAB X IDE. MPLIB librarian is an object librarian for use with COFF object modules created using either MPASM assembler (mpasm or mpasmwin v2.0) or MPLAB C18 C Compiler.

MPLINK™ Object Linker
MPLINK linker is an object linker for the Microchip MPASM assembler and the Microchip C18 C compiler. MPLINK linker also may be used with the Microchip MPLIB librarian. MPLINK linker is designed to be used with MPLAB IDE/MPLAB X IDE, though it does not have to be.

MRU
Most Recently Used. Refers to files and windows available to be selected from MPLAB IDE/MPLAB X IDE main pull down menus.

N
Native Data Size
For Native trace, the size of the variable used in a Watches window must be of the same size as the selected device’s data memory: bytes for PIC18 devices and words for 16-bit devices.

Nesting Depth
The maximum level to which macros can include other macros.

Node
MPLAB IDE/MPLAB X IDE project component.

Non-Extended Mode (PIC18 MCUs)
In Non-Extended mode, the compiler will not utilize the extended instructions nor the indexed with literal offset addressing.
Non Real Time
Refers to the processor at a breakpoint or executing single-step instructions or MPLAB IDE/MPLAB X IDE being run in simulator mode.

Non-Volatile Storage
A storage device whose contents are preserved when its power is off.

NOP
No Operation. An instruction that has no effect when executed except to advance the program counter.

O
Object Code/Object File
Object code is the machine code generated by an assembler or compiler. An object file is a file containing machine code and possibly debug information. It may be immediately executable or it may be relocatable, requiring linking with other object files, e.g., libraries, to produce a complete executable program.

Object File Directives
Directives that are used only when creating an object file.

Octal
The base 8 number system that only uses the digits 0-7. The rightmost digit counts ones, the next digit counts multiples of 8, then $8^2 = 64$, etc.

Off-Chip Memory
Off-chip memory refers to the memory selection option for the PIC18 device where memory may reside on the target board, or where all program memory may be supplied by the emulator. The Memory tab accessed from Options>Development Mode provides the Off-Chip Memory selection dialog box.

Opcodes
Operational Codes. See Mnemonics.

Operators
Symbols, like the plus sign ‘+’ and the minus sign ‘-’, that are used when forming well-defined expressions. Each operator has an assigned precedence that is used to determine order of evaluation.

OTP
One Time Programmable. EPROM devices that are not in windowed packages. Since EPROM needs ultraviolet light to erase its memory, only windowed devices are erasable.

P
Pass Counter
A counter that decrements each time an event (such as the execution of an instruction at a particular address) occurs. When the pass count value reaches zero, the event is satisfied. You can assign the Pass Counter to break and trace logic, and to any sequential event in the complex trigger dialog.

PC
Personal Computer or Program Counter.

PC Host
Any computer running a supported Windows operating system.
Persistent Data
Data that is never cleared or initialized. Its intended use is so that an application can preserve data across a device Reset.

Phantom Byte
An unimplemented byte in dsPIC architecture used when treating the 24-bit instruction word as if it were a 32-bit instruction word. Phantom bytes appear in dsPIC hex files.

PIC MCUs
PIC microcontrollers (MCUs) refers to all Microchip microcontroller families.

PICkit 3
Microchip's developmental device programmers with debug capability through Debug Express. See the Readme files for each tool to see which devices are supported.

Plug-ins
The MPLAB IDE/MPLAB X IDE has both built-in components and plug-in modules to configure the system for a variety of software and hardware tools. Several plug-in tools may be found under the Tools menu.

Pod
The enclosure for an in-circuit emulator or debugger. Other names are “Puck,” if the enclosure is round, and “Probe” (not to be confused with logic probes).

Power-on-Reset Emulation
A software randomization process that writes random values in data RAM areas to simulate uninitialized values in RAM upon initial power application.

Pragma
A directive that has meaning to a specific compiler. Often a pragma is used to convey implementation-defined information to the compiler.

Precedence
Rules that define the order of evaluation in expressions.

Production Programmer
A production programmer is a programming tool that has resources designed in to program devices rapidly. It has the capability to program at various voltage levels and completely adheres to the programming specification. Programming a device as fast as possible is of prime importance in a production environment where time is of the essence as the application circuit moves through the assembly line.

Profile
For MPLAB SIM simulator, a summary listing of executed stimulus by register.

Program Counter
The location that contains the address of the instruction that is currently executing.

Program Counter Unit
16-bit assembler – A conceptual representation of the layout of program memory. The program counter increments by 2 for each instruction word. In an executable section, 2 program counter units are equivalent to 3 bytes. In a read-only section, 2 program counter units are equivalent to 2 bytes.

Program Memory
MPLAB IDE/MPLAB X IDE – The memory area in a device where instructions are stored. Also, the memory in the emulator or simulator containing the downloaded target application firmware. 16-bit assembler/compiler – The memory area in a device where instructions are stored.
Project
A project contains the files needed to build an application (source code, linker script files, etc.) along with their associations to various build tools and build options.

Prologue
A portion of compiler-generated code that is responsible for allocating stack space, preserving registers and performing any other machine-specific requirement specified in the runtime model. This code executes before any user code for a given function.

Prototype System
A term referring to a user’s target application, or target board.

Psect
The OCG equivalent of a GCC section, short for program section. A block of code or data which is treated as a whole by the linker.

PWM Signals
Pulse Width Modulation Signals. Certain PIC MCU devices have a PWM peripheral.

Q
Qualifier
An address or an address range used by the Pass Counter or as an event before another operation in a complex trigger.

R
Radix
The number base, hex, or decimal, used in specifying an address.

RAM
Random Access Memory (Data Memory). Memory in which information can be accessed in any order.

Raw Data
The binary representation of code or data associated with a section.

Read Only Memory
Memory hardware that allows fast access to permanently stored data but prevents addition to or modification of the data.

Real Time
When an in-circuit emulator or debugger is released from the halt state, the processor runs in Real Time mode and behaves exactly as the normal chip would behave. In Real Time mode, the real time trace buffer of an emulator is enabled and constantly captures all selected cycles, and all break logic is enabled. In an in-circuit emulator or debugger, the processor executes in real time until a valid breakpoint causes a halt, or until the user halts the execution.

In the simulator, real time simply means execution of the microcontroller instructions as fast as they can be simulated by the host CPU.

Recursive Calls
A function that calls itself, either directly or indirectly.

Recursion
The concept that a function or macro, having been defined, can call itself. Great care should be taken when writing recursive macros; it is easy to get caught in an infinite loop where there will be no exit from the recursion.
Reentrant
A function that may have multiple, simultaneously active instances. This may happen due to either direct or indirect recursion or through execution during interrupt processing.

Relaxation
The process of converting an instruction to an identical, but smaller instruction. This is useful for saving on code size. MPLAB XC16 currently knows how to relax a CALL instruction into an RCALL instruction. This is done when the symbol that is being called is within +/- 32k instruction words from the current instruction.

Relocatable
An object whose address has not been assigned to a fixed location in memory.

Relocatable Section
16-bit assembler – A section whose address is not fixed (absolute). The linker assigns addresses to relocatable sections through a process called relocation.

Relocation
A process performed by the linker in which absolute addresses are assigned to relocatable sections and all symbols in the relocatable sections are updated to their new addresses.

ROM
Read Only Memory (Program Memory). Memory that cannot be modified.

Run
The command that releases the emulator from halt, allowing it to run the application code and change or respond to I/O in real time.

Run-time Model
Describes the use of target architecture resources.

Runtime Watch
A Watches window where the variables change in as the application is run. See individual tool documentation to determine how to set up a runtime watch. Not all tools support runtime watches.

S

Scenario
For MPLAB SIM simulator, a particular setup for stimulus control.

Section
The GCC equivalent of an OCG psect. A block of code or data which is treated as a whole by the linker.

Section Attribute
A GCC characteristic ascribed to a section (e.g., an access section).

Sequenced Breakpoints
Breakpoints that occur in a sequence. Sequence execution of breakpoints is bottom-up; the last breakpoint in the sequence occurs first.

Serialized Quick Turn Programming
Serialization allows you to program a serial number into each microcontroller device that the Device Programmer programs. This number can be used as an entry code, password or ID number.
Shell
The MPASM assembler shell is a prompted input interface to the macro assembler. There are two MPASM assembler shells: one for the DOS version and one for the Windows operating system version.

Simulator
A software program that models the operation of devices.

Single Step
This command steps through code, one instruction at a time. After each instruction, MPLAB IDE/MPLAB X IDE updates register windows, watch variables, and status displays so you can analyze and debug instruction execution. You can also single step C compiler source code, but instead of executing single instructions, MPLAB IDE/MPLAB X IDE will execute all assembly level instructions generated by the line of the high level C statement.

Skew
The information associated with the execution of an instruction appears on the processor bus at different times. For example, the executed opcodes appears on the bus as a fetch during the execution of the previous instruction, the source data address and value and the destination data address appear when the opcodes is actually executed, and the destination data value appears when the next instruction is executed. The trace buffer captures the information that is on the bus at one instance. Therefore, one trace buffer entry will contain execution information for three instructions. The number of captured cycles from one piece of information to another for a single instruction execution is referred to as the skew.

Skid
When a hardware breakpoint is used to halt the processor, one or more additional instructions may be executed before the processor halts. The number of extra instructions executed after the intended breakpoint is referred to as the skid.

Source Code
The form in which a computer program is written by the programmer. Source code is written in a formal programming language which can be translated into machine code or executed by an interpreter.

Source File
An ASCII text file containing source code.

Special Function Registers (SFRs)
The portion of data memory (RAM) dedicated to registers that control I/O processor functions, I/O status, timers or other modes or peripherals.

SQTP
See Serialized Quick Turn Programming.

Stack, Hardware
Locations in PIC microcontroller where the return address is stored when a function call is made.

Stack, Software
Memory used by an application for storing return addresses, function parameters, and local variables. This memory is dynamically allocated at runtime by instructions in the program. It allows for reentrant function calls.
Stack, Compiled
A region of memory managed and allocated by the compiler in which variables are statically assigned space. It replaces a software stack when such mechanisms cannot be efficiently implemented on the target device. It precludes reentrancy.

Static RAM or SRAM
Static Random Access Memory. Program memory you can read/write on the target board that does not need refreshing frequently.

Status Bar
The Status Bar is located on the bottom of the MPLAB IDE/MPLAB X IDE window and indicates such current information as cursor position, development mode and device, and active tool bar.

Step Into
This command is the same as Single Step. Step Into (as opposed to Step Over) follows a CALL instruction into a subroutine.

Step Over
Step Over allows you to debug code without stepping into subroutines. When stepping over a CALL instruction, the next breakpoint will be set at the instruction after the CALL. If for some reason the subroutine gets into an endless loop or does not return properly, the next breakpoint will never be reached. The Step Over command is the same as Single Step except for its handling of CALL instructions.

Step Out
Step Out allows you to step out of a subroutine which you are currently stepping through. This command executes the rest of the code in the subroutine and then stops execution at the return address to the subroutine.

Stimulus
Input to the simulator, i.e., data generated to exercise the response of simulation to external signals. Often the data is put into the form of a list of actions in a text file. Stimulus may be asynchronous, synchronous (pin), clocked and register.

Stopwatch
A counter for measuring execution cycles.

Storage Class
Determines the lifetime of the memory associated with the identified object.

Storage Qualifier
Indicates special properties of the objects being declared (e.g., const).

Symbol
A symbol is a general purpose mechanism for describing the various pieces which comprise a program. These pieces include function names, variable names, section names, file names, struct/enum/union tag names, etc. Symbols in MPLAB IDE/MPLAB X IDE refer mainly to variable names, function names and assembly labels. The value of a symbol after linking is its value in memory.

Symbol, Absolute
Represents an immediate value such as a definition through the assembly .equ directive.

System Window Control
The system window control is located in the upper left corner of windows and some dialogs. Clicking on this control usually pops up a menu that has the items “Minimize,” “Maximize” and “Close.”
T
Target
Refers to user hardware.

Target Application
Software residing on the target board.

Target Board
The circuitry and programmable device that makes up the target application.

Target Processor
The microcontroller device on the target application board.

Template
Lines of text that you build for inserting into your files at a later time. The MPLAB Editor stores templates in template files.

Tool Bar
A row or column of icons that you can click on to execute MPLAB IDE/MPLAB X IDE functions.

Trace
An emulator or simulator function that logs program execution. The emulator logs program execution into its trace buffer which is uploaded to the MPLAB IDE/MPLAB X IDE trace window.

Trace Memory
Trace memory contained within the emulator. Trace memory is sometimes called the trace buffer.

Trace Macro
A macro that will provide trace information from emulator data. Since this is a software trace, the macro must be added to code, the code must be recompiled or reassembled, and the target device must be programmed with this code before trace will work.

Trigger Output
Trigger output refers to an emulator output signal that can be generated at any address or address range, and is independent of the trace and breakpoint settings. Any number of trigger output points can be set.

Trigraphs
Three-character sequences, all starting with ?? (two consecutive question marks), that are defined by ISO C as replacements for single characters.

U
Unassigned Section
A section which has not been assigned to a specific target memory block in the linker command file. The linker must find a target memory block in which to allocate an unassigned section.

Uninitialized Data
Data which is defined without an initial value. In C,

```c
int myVar;
```

defines a variable which will reside in an uninitialized data section.

Upload
The Upload function transfers data from a tool, such as an emulator or programmer, to the host computer or from the target board to the emulator.
**USB**
Universal Serial Bus. An external peripheral interface standard for communication between a computer and external peripherals over a cable using bi-serial transmission. USB 1.0/1.1 supports data transfer rates of 12 Mbps. Also referred to as high-speed USB, USB 2.0 supports data rates up to 480 Mbps.

**V**

**Vector**
The memory locations that an application will jump to when either a Reset or interrupt occurs.

**Volatile**
A variable qualifier which prevents the compiler applying optimizations that affect how the variable is accessed in memory.

**W**

**Warning**
MPLAB IDE/MPLAB X IDE – An alert that is provided to warn you of a situation that would cause physical damage to a device, software file, or equipment.

16-bit assembler/compiler – Warnings report conditions that may indicate a problem, but do not halt processing.

**Watch Variable**
A variable that you may monitor during a debugging session in a Watches window.

**Watches Window**
Watches windows contain a list of watch variables that are updated at each breakpoint.

**Watchdog Timer (WDT)**
A timer on a PIC microcontroller that resets the processor after a selectable length of time. The WDT is enabled or disabled and set up using Configuration bits.

**Workbook**
For MPLAB SIM stimulator, a setup for generation of SCL stimulus.
# Index

<table>
<thead>
<tr>
<th>B</th>
<th>H</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bootloader Mode .................................................. 37</td>
<td>Hardware Tool Emergency Boot Firmware Recovery Utility ........................................... 38</td>
<td>Cables ............................................................... 61</td>
<td>Debug Executive .................................................. 24</td>
<td>Emergency Boot Firmware Recovery Utility How to Use ......................................................... 38</td>
<td>Firmware Downloads ............................................. 59</td>
<td>General Corrective Actions ...................................... 50</td>
</tr>
<tr>
<td>How to Invoke ....................................................... 37</td>
<td>Header Board Specification .......................................................... 9</td>
<td>Capacitors .................................................................. 20, 21</td>
<td>Debug Mode Sequence of Operations .................................. 23</td>
<td>Emergency Boot Firmware Recovery Utility How to Use ......................................................... 38</td>
<td>Freeze Peripherals Setup .......................................... 58</td>
<td></td>
</tr>
<tr>
<td>Breakpoints Hardware .................................................. 31</td>
<td>Hibernate mode .................................................................. 40, 61</td>
<td>Circuits That Will Prevent the Debugger From Functioning ......................................... 21</td>
<td>Debug, Top Reasons Why You Can’t ......................... 35</td>
<td>Freeze Peripherals Setup .......................................... 58</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Setup .................................................................. 31</td>
<td>How to Invoke the Bootloader Mode ........................................ 37</td>
<td>Clock Speed .................................................................. 59</td>
<td>Debug/Program Quick Reference ................................. 28</td>
<td>Freeze on Halt .......................................................... 40</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Software .................................................................. 31</td>
<td>How to Use the Hardware Tool Emergency Boot Firmware Recovery Utility ........................................... 38</td>
<td>Code Protect .................................................................. 22</td>
<td>Freeze Peripherals Setup .......................................... 58</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Button Area .............................................................. 62</td>
<td>Hubs, USB .................................................................. 61</td>
<td>Command-line Programming ........................................ 28</td>
<td>Freeze Peripherals Setup .......................................... 58</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>I</th>
<th>L</th>
<th>M</th>
<th>P</th>
<th>Q</th>
</tr>
</thead>
<tbody>
<tr>
<td>ICD Headers ............................................................. 15</td>
<td>Limitations .................................................................. 29</td>
<td>Maintain active connection to hardware tool .................. 28</td>
<td>PC, Power Down .......................................................... 40, 61</td>
<td>Quick Reference</td>
</tr>
<tr>
<td>ICD3CMD .................................................................. 28</td>
<td>Micro SD Card Slot ..................................................... 63</td>
<td>Memories to Program .................................................. 56</td>
<td>PGC .................................................................. 19, 20, 21, 22, 23</td>
<td>Debug/Program ................................................. 28</td>
</tr>
<tr>
<td>ICSP .................................................................. 23, 24</td>
<td>Memory Ranges .......................................................... 56</td>
<td>Memory Extension Kits .................................................. 15</td>
<td>PGD .................................................................. 19, 20, 21, 22, 23</td>
<td></td>
</tr>
<tr>
<td>ID Memory .................................................................. 56</td>
<td>Micro SD Card Slot ..................................................... 63</td>
<td>PICkit 4 Components .................................................. 15</td>
<td>PICkit 4 Defined ....................................................... 13</td>
<td></td>
</tr>
<tr>
<td>Internet Address, Microchip ...................................... 69</td>
<td>Modular Interface Cable .................................................. 22</td>
<td>myMicrochip Personalized Notification Service .............. 69</td>
<td>PIM .................................................................. 18</td>
<td></td>
</tr>
<tr>
<td>Internet Address, Microchip ...................................... 69</td>
<td>Power .................................................................. 58</td>
<td>Power-Down mode ....................................................... 40, 61</td>
<td>Power .................................................................. 58</td>
<td></td>
</tr>
<tr>
<td>Header Board Specification ........................................ 9</td>
<td>Preserve Memory ......................................................... 57</td>
<td>Processor Extension Kits .................................................. 15</td>
<td>Processor Extension Kits .................................................. 15</td>
<td></td>
</tr>
<tr>
<td>Hibernate mode .................................................................. 40, 61</td>
<td>Program Speed .......................................................... 36</td>
<td>Rendering ................................................................. 14, 28</td>
<td>Rendering ................................................................. 14, 28</td>
<td></td>
</tr>
<tr>
<td>How to Invoke the Bootloader Mode ........................................ 37</td>
<td>Programming Command-line ........................................ 28</td>
<td>Project Properties Dialog ............................................. 55</td>
<td>Project Properties Dialog ............................................. 55</td>
<td></td>
</tr>
<tr>
<td>How to Use the Hardware Tool Emergency Boot Firmware Recovery Utility ........................................... 38</td>
<td>Production ................................................................. 14, 28</td>
<td>Pull-ups .................................................................. 21</td>
<td>Pull-ups .................................................................. 21</td>
<td></td>
</tr>
<tr>
<td>How to Use the Hardware Tool Emergency Boot Firmware Recovery Utility ........................................... 38</td>
<td></td>
<td>Quick Reference Debug/Program ................................................. 28</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

© 2018 Microchip Technology Inc. DS50002751B-page 91
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reading, Recommended</td>
<td>9</td>
</tr>
<tr>
<td>Readme</td>
<td>9</td>
</tr>
<tr>
<td>Reserved Resources by Device</td>
<td>25</td>
</tr>
<tr>
<td>Resistors</td>
<td>21</td>
</tr>
<tr>
<td>Single In-Line</td>
<td>13</td>
</tr>
<tr>
<td>Software Breakpoints Selection</td>
<td>57</td>
</tr>
<tr>
<td>SQTP</td>
<td>28</td>
</tr>
<tr>
<td>Standard Communication</td>
<td></td>
</tr>
<tr>
<td>Connections</td>
<td>19</td>
</tr>
<tr>
<td>Standard Communication Hardware</td>
<td>64</td>
</tr>
<tr>
<td>Standard ICSP Device Communication</td>
<td>18</td>
</tr>
<tr>
<td>Stopwatch</td>
<td>31</td>
</tr>
<tr>
<td>Table Read Protect</td>
<td>22</td>
</tr>
<tr>
<td>Target Connection</td>
<td></td>
</tr>
<tr>
<td>Circuitry</td>
<td>19</td>
</tr>
<tr>
<td>Improper Circuits</td>
<td>21</td>
</tr>
<tr>
<td>Standard</td>
<td>19</td>
</tr>
<tr>
<td>Target Device</td>
<td>22</td>
</tr>
<tr>
<td>Target Device ID (0x0)</td>
<td>36</td>
</tr>
<tr>
<td>Theory of Operation</td>
<td>17</td>
</tr>
<tr>
<td>Transition Socket</td>
<td></td>
</tr>
<tr>
<td>Specification</td>
<td>9, 30</td>
</tr>
<tr>
<td>USB</td>
<td>61, 89</td>
</tr>
<tr>
<td>Cables</td>
<td>15</td>
</tr>
<tr>
<td>Hubs</td>
<td>61</td>
</tr>
<tr>
<td>USB drivers</td>
<td>27</td>
</tr>
<tr>
<td>USB Port</td>
<td>62</td>
</tr>
<tr>
<td>User ID Memory</td>
<td>56</td>
</tr>
<tr>
<td>Vcap</td>
<td>20</td>
</tr>
<tr>
<td>Vdd</td>
<td>19, 20</td>
</tr>
<tr>
<td>Vpp</td>
<td>19, 20, 21, 22</td>
</tr>
<tr>
<td>Vss</td>
<td>19, 20</td>
</tr>
<tr>
<td>Watchdog Timer</td>
<td>22, 89</td>
</tr>
<tr>
<td>Web Site, Microchip</td>
<td>69</td>
</tr>
</tbody>
</table>
# Worldwide Sales and Service

## AMERICAS

<table>
<thead>
<tr>
<th>Location</th>
<th>Address</th>
<th>Phone(s)</th>
<th>Fax(es)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corporate Office</td>
<td>2355 West Chandler Blvd. Chandler, AZ 85224-6199</td>
<td>Tel: 480-792-7200</td>
<td>Fax: 480-792-7277</td>
</tr>
<tr>
<td>Technical Support</td>
<td><a href="http://www.microchip.com/">http://www.microchip.com/</a> support</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Web Address:</td>
<td><a href="http://www.microchip.com">www.microchip.com</a></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Atlanta</td>
<td>Duluth, GA</td>
<td>Tel: 678-957-9614</td>
<td>Fax: 678-957-1455</td>
</tr>
<tr>
<td>Austin, TX</td>
<td>Tel: 512-257-3370</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Boston</td>
<td>Westborough, MA</td>
<td>Tel: 774-760-0087</td>
<td>Fax: 774-760-0088</td>
</tr>
<tr>
<td>Chicago</td>
<td>Itasca, IL</td>
<td>Tel: 630-285-0071</td>
<td>Fax: 630-285-0075</td>
</tr>
<tr>
<td>Dallas</td>
<td>Addison, TX</td>
<td>Tel: 972-818-7423</td>
<td>Fax: 972-818-2924</td>
</tr>
<tr>
<td>Detroit</td>
<td>Novi, MI</td>
<td>Tel: 248-848-4000</td>
<td></td>
</tr>
<tr>
<td>Houston, TX</td>
<td>Tel: 281-894-5983</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Indianapolis</td>
<td>Noblesville, IN</td>
<td>Tel: 317-773-8323</td>
<td>Fax: 317-773-5453</td>
</tr>
<tr>
<td>Los Angeles</td>
<td>Mission Viejo, CA</td>
<td>Tel: 949-462-9523</td>
<td>Fax: 949-462-9608</td>
</tr>
<tr>
<td>Raleigh, NC</td>
<td>Tel: 919-844-7510</td>
<td></td>
<td></td>
</tr>
<tr>
<td>New York, NY</td>
<td>Tel: 631-435-6000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>San Jose, CA</td>
<td>Tel: 408-735-9110</td>
<td>Tel: 408-436-4270</td>
<td></td>
</tr>
<tr>
<td>Canada - Toronto</td>
<td>Tel: 905-695-1980</td>
<td>Fax: 905-695-2078</td>
<td></td>
</tr>
</tbody>
</table>

## ASIA/PACIFIC

<table>
<thead>
<tr>
<th>Location</th>
<th>Address</th>
<th>Phone(s)</th>
<th>Fax(es)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Australia - Sydney</td>
<td>Tel: 61-2-9888-6733</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Beijing</td>
<td>Tel: 86-10-8569-7000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Chengdu</td>
<td>Tel: 86-28-8665-5511</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Chongqing</td>
<td>Tel: 86-23-8980-9588</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Dongguan</td>
<td>Tel: 86-769-8702-9880</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Guangzhou</td>
<td>Tel: 86-20-8755-8029</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Hangzhou</td>
<td>Tel: 86-571-8792-8115</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Hong Kong SAR</td>
<td>Tel: 852-2943-5100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Nanjing</td>
<td>Tel: 86-25-8473-2460</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Qingdao</td>
<td>Tel: 86-532-8502-7355</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Shanghai</td>
<td>Tel: 86-21-3326-8000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Shenyang</td>
<td>Tel: 86-24-2334-2829</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Shenzhen</td>
<td>Tel: 86-755-8864-2200</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Suzhou</td>
<td>Tel: 86-186-6233-1526</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Wuhan</td>
<td>Tel: 86-27-5980-5300</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Xian</td>
<td>Tel: 86-29-8833-7252</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Xiamen</td>
<td>Tel: 86-592-2386138</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Zuhai</td>
<td>Tel: 86-756-3210040</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## ASIA/PACIFIC

<table>
<thead>
<tr>
<th>Location</th>
<th>Address</th>
<th>Phone(s)</th>
<th>Fax(es)</th>
</tr>
</thead>
<tbody>
<tr>
<td>India - Bangalore</td>
<td>Tel: 91-80-3090-4444</td>
<td></td>
<td></td>
</tr>
<tr>
<td>India - New Delhi</td>
<td>Tel: 91-11-4160-8631</td>
<td></td>
<td></td>
</tr>
<tr>
<td>India - Pune</td>
<td>Tel: 91-20-4121-0141</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Japan - Osaka</td>
<td>Tel: 81-6-6152-7160</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Japan - Tokyo</td>
<td>Tel: 81-3-6880-3770</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Korea - Daegu</td>
<td>Tel: 82-53-744-4301</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Korea - Seoul</td>
<td>Tel: 82-2-554-7200</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Malaysia - Kuala Lumpur</td>
<td>Tel: 60-3-7651-7906</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Malaysia - Penang</td>
<td>Tel: 60-4-227-8870</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Philippines - Manila</td>
<td>Tel: 63-2-634-9065</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Singapore</td>
<td>Tel: 65-6334-8870</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Taiwan - Hsin Chu</td>
<td>Tel: 886-3-577-8366</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Taiwan - Kaohsiung</td>
<td>Tel: 886-7-213-7830</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Taiwan - Taipei</td>
<td>Tel: 886-2-2508-8600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thailand - Bangkok</td>
<td>Tel: 66-2-694-1351</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vietnam - Ho Chi Minh</td>
<td>Tel: 84-28-5448-2100</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## EUROPE

<table>
<thead>
<tr>
<th>Location</th>
<th>Address</th>
<th>Phone(s)</th>
<th>Fax(es)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Austria - Wels</td>
<td>Tel: 43-7242-2244-39</td>
<td>Tel: 43-7242-2244-393</td>
<td></td>
</tr>
<tr>
<td>Denmark - Copenhagen</td>
<td>Tel: 45-4450-2828</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Finland - Espoo</td>
<td>Tel: 358-9-4520-820</td>
<td></td>
<td></td>
</tr>
<tr>
<td>France - Paris</td>
<td>Tel: 33-1-69-53-63-20</td>
<td>Tel: 33-1-69-30-90-79</td>
<td></td>
</tr>
<tr>
<td>Germany - Garching</td>
<td>Tel: 49-8931-9700</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Germany - Haan</td>
<td>Tel: 49-2129-3766400</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Germany - Heilbronn</td>
<td>Tel: 49-7131-67-3636</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Germany - Karlsruhe</td>
<td>Tel: 49-721-625370</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Germany - Munich</td>
<td>Tel: 49-89-627-144-0</td>
<td>Fax: 49-89-627-144-44</td>
<td></td>
</tr>
<tr>
<td>Germany - Rosenheim</td>
<td>Tel: 49-8031-354-560</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Israel - Ra'anana</td>
<td>Tel: 972-9-744-7705</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Italy - Milan</td>
<td>Tel: 39-0331-742611</td>
<td>Fax: 39-0331-466781</td>
<td></td>
</tr>
<tr>
<td>Italy - Padova</td>
<td>Tel: 39-049-7625286</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Netherlands - Drunen</td>
<td>Tel: 31-416-690399</td>
<td>Fax: 31-416-690340</td>
<td></td>
</tr>
<tr>
<td>Norway - Trondheim</td>
<td>Tel: 47-7289-7561</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Poland - Warsaw</td>
<td>Tel: 48-22-3325737</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Romania - Bucharest</td>
<td>Tel: 40-21-407-87-50</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Spain - Madrid</td>
<td>Tel: 34-91-708-08-90</td>
<td>Fax: 34-91-708-08-91</td>
<td></td>
</tr>
<tr>
<td>Sweden - Gothenberg</td>
<td>Tel: 46-31-704-60-40</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sweden - Stockholm</td>
<td>Tel: 46-8-5090-4654</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UK - Wokingham</td>
<td>Tel: 44-118-921-5800</td>
<td>Fax: 44-118-921-5820</td>
<td></td>
</tr>
</tbody>
</table>

© 2018 Microchip Technology Inc.